Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither is any liability assumed for damages resulting from the use of the information herein. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson Corporation.

EPSON® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark of Seiko Epson Corporation.

PRINT Image Matching™ and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation. Copyright © 2001 Seiko Epson Corporation. All rights reserved.

Intel® is a registered trademark of Intel Corporation.

PowerPC® is a registered trademark of International Business Machines Corporation.

Epson Scan software is based in part on the work of the Independent JPEG Group.

libtiff

Copyright © 1988-1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

Apple®, Macintosh®, Mac OS®, and OS X® are registered trademarks of Apple Inc.

ABBYY® and ABBYY FineReader® names and logos are registered trademarks of ABBYY Software House.

Adobe, Adobe Reader, Acrobat, and Photoshop are trademarks of Adobe systems Incorporated, which may be registered in certain jurisdictions.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Copyright © 2012 Seiko Epson Corporation. All rights reserved.
Contents

Copyright and Trademarks
Copyright and Trademarks. ................................ 2

Introduction
Where to Find Information. .............................. 8
Caution, Important and Note. ............................ 8
Operating System Versions. ............................... 8
Using Epson Connect Service. ............................ 9

Important Instructions
Safety Instructions. ......................................... 10
Product Advisories and Warnings. ......................... 10
Setting up/using the product. ............................. 11
Using the product with a wireless connection ......... 12
Using the LCD screen. ................................. 12
Handling ink cartridges. ................................. 12
Restrictions on Copying. ................................. 13
Protecting Your Personal Information. ................. 13

Getting to Know Your Product
Available Features. ....................................... 14
Product Parts. ............................................ 14
Guide to the Control Panel. ............................. 16
 Buttons and LCD. .................................... 17
 Lights. .................................................. 18

Paper and Media Handling
Introduction to Using, Loading, and Storing Media. . 19
 Storing paper. ........................................... 19
 Selecting Paper. ......................................... 19
 Paper type settings on the LCD screen. ............. 21
 Paper type settings from the printer driver. .......... 21
 Loading Paper and Envelopes. ........................ 22
 Placing Originals. ....................................... 24
 Automatic Document Feeder (ADF). .................... 24
 Scanner glass. .......................................... 26

Copying
Copying Documents. ..................................... 28
 Basic copying. .......................................... 28
 Copy Mode Menu List. .................................. 28

Printing
Printer Driver and Status Monitor. ...................... 29
 Accessing the printer driver for Windows. ........... 29
 Accessing the printer driver for Mac OS X. .......... 30
 Basic Operations. ....................................... 31
 Basic printing. .......................................... 31
 Canceling printing. ..................................... 34
 Other Options. .......................................... 35
 Printing photos the easy way. .......................... 35
 Product presets (For Windows Only). ................. 36
 2-sided printing (for Windows only). ................. 36
 Fit to page printing. .................................... 38
 Pages per sheet printing. ............................... 39
 Sharing the Product for Printing. ....................... 40
 Setup for Windows. ...................................... 40
 Setup for Mac OS X. .................................... 42

Scanning
Let’s Try Scanning. ....................................... 43
 Starting a Scan. ......................................... 43
 Image Adjustment Features. ............................ 45
 Basic Scanning from the Control Panel. ............... 47
 Scan mode menu list. ................................... 48
 Basic Scanning from Your Computer. ................. 48
 Scanning in Home Mode. ............................... 48
 Scanning in Office Mode. ................................ 50
 Scanning in Professional Mode. ........................ 52
 Previewing and Adjusting the Scan Area. .............. 54
 Various Types of Scanning. ............................. 56
 Scanning a Magazine. ................................... 56
 Scanning Multiple Documents to a PDF File ......... 57
 Scanning a Photo. ....................................... 60
 Software Information. ................................... 61
 Starting Epson Scan Driver. ............................ 61
 Starting Other Scanning Software. ...................... 62
Contents

Faxing
Introducing FAX Utility ........................................... 64
Connecting to a Phone Line ........................................ 64
About a phone cable ............................................. 64
Using the phone line for fax only ................................ 65
Sharing line with phone device ................................... 65
Checking the fax connection .................................... 67
Notices when the power is turned off ............................ 68
Setting Up Fax Features .......................................... 68
Setting up speed dial entries ................................... 68
Setting up group dial entries ................................... 69
Creating header information .................................... 70
Sending Faxes ..................................................... 71
Sending faxes by entering a number ............................. 71
Sending faxes using speed dial/group dial ...................... 71
Sending faxes by broadcasting .................................. 72
Sending a fax at a specified time ................................ 73
Sending a fax from a connected phone ......................... 74
Receiving Faxes ................................................... 75
Setting up to receive faxes automatically ....................... 75
Receiving faxes manually ....................................... 76
Receive a fax by polling ......................................... 76
Printing Reports ................................................... 77
Fax Mode Menu List ............................................... 78

Menu List of Control Panel
Copy Mode .......................................................... 79
Fax Mode ........................................................... 82
Scan Mode .......................................................... 87

Replacing Ink Cartridges
Ink Cartridge Safety Instructions, Precautions, and Specifications .................................. 89
Safety instructions .................................................. 89
Precautions on ink cartridge replacement ....................... 90
Ink Cartridge Specifications ..................................... 91
Checking the Ink Cartridge Status ................................ 91
For Windows ..................................................... 91
For Mac OS X .................................................... 92
Using the control panel ......................................... 93
Temporarily Printing with Black Ink When Color Ink Cartridges Are Expended ......................... 94
For Windows ..................................................... 94
For Mac OS X .................................................... 96
Conserving Black Ink When the Cartridge Is Low (For Windows Only) ................................. 97
Replacing an Ink Cartridge ....................................... 98

Maintaining Your Product and Software
Using the control panel .......................................... 98
For Windows ..................................................... 101
For Mac OS X .................................................... 101

Transferring Data Using an External Storage Device
Precautions on Storage Devices .................................. 116
Copying Files Between a Storage Device and Your Computer ........................................ 116
Copying files to your computer .................................. 116
Saving files to a storage device .................................. 117
Contents

**Error Indicators**
Error Messages on the Control Panel .................. 118

**Troubleshooting for Printing/Copying**
Diagnosing the Problem .................................. 120
Checking product status .................................. 121
Paper Jams .............................................. 123
  Removing jammed paper from inside the product ... 124
  Removing jammed paper from the Automatic Document Feeder (ADF) .................................. 125
Preventing paper jams .................................. 127
Reprinting after a paper jam (for Windows only) .... 127
Print Quality Help ....................................... 128
  Horizontal banding ................................... 129
  Vertical banding or misalignment ..................... 129
  Incorrect or missing colors ........................... 129
  Blurry or smeared print ................................ 130
Miscellaneous Printout Problems ....................... 131
  Incorrect or garbled characters ...................... 131
  Incorrect margins ..................................... 131
  Printout has a slight slant ........................... 131
  Size or position of copied image is incorrect ....... 131
  Inverted image ....................................... 132
  Blank pages print .................................... 132
  Printed side is smeared or scuffed .................... 132
  Printing is too slow .................................. 132
Paper Does Not Feed Correctly .......................... 133
  Paper does not feed .................................. 133
  Multiple pages feed .................................. 133
  Paper is improperly loaded ............................ 134
  Paper is not ejected fully or is wrinkled ............ 134
The Product Does Not Print ............................... 134
  All lights are off .................................... 134
  Only the power light is on ............................ 134
  An ink error is indicated after you replace the cartridge ................................................. 135
Increasing the Print Speed (For Windows Only) ..... 136
Other Problem .......................................... 137
  Printing plain papers quietly ......................... 137

**Troubleshooting for Scanning**
Problems Indicated by Messages on the LCD Screen or Status Light .................................. 138
Problems When Starting a Scan .......................... 138

Using the Automatic Document Feeder (ADF) ......... 138
Using the button ....................................... 139
Using scanning software other than Epson Scan driver ....................................................... 140
Problems When Feeding Paper ........................... 140
  The paper gets dirty .................................. 140
  Multiple sheets of paper are fed ..................... 140
  The paper jams in the Automatic Document Feeder (ADF) ................................................. 140
Problems With Scanning Time ........................... 141
Problems With Scanned Images ........................... 141
  Scan quality is unsatisfactory ........................ 141
  The scanning area or direction is unsatisfactory ................................................................. 142
Problems Remain After Trying All Solutions ......... 143

**Troubleshooting for Faxing**
Cannot send and receive fax ................................ 144
Quality problems (sending) ............................... 144
Quality problems (receiving) ............................. 145
Answering machine cannot answer voice calls ....... 145
Incorrect time .......................................... 145

**Product Information**
Ink Cartridges .......................................... 146
System Requirements ..................................... 146
  For Windows .......................................... 146
  For Mac OS X .......................................... 147
Technical Specifications ................................ 147
  Printer specifications .................................. 147
  Scanner specifications ................................ 149
  Automatic Document Feeder (ADF) specifications ................................................................. 150
  Fax specifications ...................................... 150
  Network interface specification ...................... 151
  Mechanical ............................................ 151
  Electrical ............................................. 152
  Environmental ......................................... 154
  Standards and approvals ................................ 154
  Interface .............................................. 155

**Where To Get Help**
Technical Support Web Site ................................ 157
Contacting Epson Support ................................ 157
Before Contacting Epson .................................. 157
Help for Users in Europe ................................ 158
## Contents

| Help for Users in Taiwan          | 158 |
| Help for Users in Australia      | 159 |
| Help for Users in Singapore      | 159 |
| Help for Users in Thailand       | 160 |
| Help for Users in Vietnam        | 160 |
| Help for Users in Indonesia      | 160 |
| Help for Users in Hong Kong      | 162 |
| Help for Users in Malaysia       | 162 |
| Help for Users in India          | 163 |
| Help for Users in the Philippines | 164 |

## Index
Introduction

Where to Find Information

The latest version of the following manuals are available on the Epson support website.
http://www.epson.eu/Support (Europe)
http://support.epson.net/ (other than Europe)

☐ Start Here (paper):

Provides you with information on setting up the product and installing the software.

☐ Basic Guide (paper):

Provides you with basic information when you are using the product without a computer. This manual may not be included depending on the model and region.

☐ User’s Guide (PDF):

Provides you with detailed operating, safety, and troubleshooting instructions. See this guide when using this product with a computer.
To view the PDF manual, you need Adobe Acrobat Reader 5.0 or later, or Adobe Reader.

☐ Network Guide (HTML):

Provides network administrators with information on both the printer driver and network settings.

Caution, Important and Note

Caution, Important, and Note in this manual are indicated as below and have the following meaning.

⚠️ Caution
must be followed carefully to avoid bodily injury.

⚠️ Important
must be observed to avoid damage to your equipment.

Note
contain useful tips and restrictions on product operation.

Operating System Versions

In this manual, the following abbreviations are used.


Mac OS X refers to Mac OS X 10.5.8, 10.6.x, 10.7.x.

Using Epson Connect Service

Using Epson Connect and other companies’ services, you can easily print directly from your smartphone, tablet PC or laptop, anytime and practically anywhere even across the globe! The services available vary by product. For more information about the printing and other services, visit the following URL:
https://www.epsonconnect.com/ (Epson Connect portal site)
http://www.epsonconnect.eu (Europe only)

You can view the Epson Connect guide by double-clicking the shortcut icon on the desktop.
Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this product. Make sure you keep this guide for future reference. Also, be sure to follow all warnings and instructions marked on the product.

- Use only the power cord supplied with the product and do not use the cord with any other equipment. Use of other cords with this product or the use of the supplied power cord with other equipment may result in fire or electric shock.

- Be sure your AC power cord meets the relevant local safety standard.

- Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by yourself, except as specifically explained in the product’s guides.

- Unplug the product and refer servicing to qualified service personnel under the following conditions: The power cord or plug is damaged; liquid has entered the product; the product has been dropped or the casing damaged; the product does not operate normally or exhibits a distinct change in performance. Do not adjust controls that are not covered by the operating instructions.

- Place the product near a wall outlet where the plug can be easily unplugged.

- Do not place or store the product outdoors, near excessive dirt or dust, water, heat sources, or in locations subject to shocks, vibrations, high temperature or humidity.

- Take care not to spill liquid on the product and not to handle the product with wet hands.

- Keep this product at least 22 cm away from cardiac pacemakers. Radio waves from this product may adversely affect the operation of cardiac pacemakers.

- If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

- Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning.

- Do not use a telephone to report a gas leak in the vicinity of the leak.

Note:
The following provides safety instructions for ink cartridges.

⇒ “Replacing Ink Cartridges” on page 89

Product Advisories and Warnings

Read and follow these instructions to avoid damaging the product or your property. Make sure you keep this guide for future reference.
**Important Instructions**

### Setting up/using the product

- Do not block or cover the vents and openings in the product.
- Use only the type of power source indicated on the product’s label.
- Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
- Avoid electrical outlets controlled by wall switches or automatic timers.
- Keep the entire computer system away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.
- The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over. Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter and leave the transformer.
- If you use an extension cord with the product, make sure that the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
- If you plan to use the product in Germany, the building installation must be protected by a 10 or 16 amp circuit breaker to provide adequate short-circuit protection and over-current protection for the product.
- When connecting the product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.
- Place the product on a flat, stable surface that extends beyond the base of the product in all directions. If you place the product by the wall, leave more than 10 cm between the back of the product and the wall. The product will not operate properly if it is tilted at an angle.
- When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down; otherwise ink may leak.
- Allow spaces behind the product for the cables, and space above the product so that you can fully raise the document cover.
- Leave enough space in front of the product for the paper to be fully ejected.
- Avoid places subject to rapid changes in temperature and humidity. Also, keep the product away from direct sunlight, strong light, or heat sources.
- Do not insert objects through the slots in the product.
- Do not put your hand inside the product or touch the ink cartridges during printing.
- Do not touch the white flat cable inside the product.
- Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause fire.
- Do not move the ink cartridge holder by hand; otherwise, you may damage the product.
Important Instructions

- Always turn the product off using the button. Do not unplug the product or turn off the power at the outlet until the LCD screen has turned off completely.

- Before transporting the product, make sure that the print head is in the home (far right) position and the ink cartridges are in place.

- Be careful not to trap your fingers when closing the scanner unit.

- If you are not going to use the product for a long period, be sure to unplug the power cord from the electrical outlet.

- Do not press too hard on the scanner glass when placing the originals.

- During the life of your product it may be necessary to replace the waste ink pad when it has become full. Whether and how often this is required will vary according to the number of pages you print, the type of material that you print and the number of cleaning cycles that the product performs. Epson Status Monitor, your LCD, or lights on the control panel will advise you when this part needs replacing. The need for replacement of the pad does not mean that your product has ceased to operate in accordance with its specifications. The replacement of this part is a routine product servicing activity within the product’s specification and is not a problem which requires repair. The Epson warranty does not therefore cover the cost of this replacement. If your product needs the pad replacing this can be performed for you by any authorised Epson service provider. It is not a user-serviceable part.

Using the product with a wireless connection

*Note:*

The availability of this feature varies by product.

- Do not use this product inside medical facilities or near medical equipment. Radio waves from this product may adversely affect the operation of electrical medical equipment.

- Do not use this product near automatically controlled devices such as automatic doors or fire alarms. Radio waves from this product may adversely affect these devices, and could lead to accidents due to malfunction.

Using the LCD screen

- The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven brightness. These are normal and do not indicate that it is damaged in any way.

- Only use a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

- The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the panel surface chips or cracks, and do not touch or attempt to remove the broken pieces.

Handling ink cartridges

We will provide ink-related safety instructions and product advice/warnings in the linked section (before “Replacing Ink Cartridges” section).

⇒ "Replacing Ink Cartridges" on page 89
Restrictions on Copying

Observe the following restrictions in order to ensure the responsible and legal use of the product.

Copying of the following items is prohibited by law:

- Bank bills, coins, government-issued marketable securities, government bond securities, and municipal securities
- Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage
- Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

- Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession tickets, etc.
- Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

**Note:**
*Copying these items may also be prohibited by law.*

Responsible use of copyrighted materials:

- Products can be misused by improperly copying copyrighted materials. Unless acting on the advice of a knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before copying published material.

Protecting Your Personal Information

This product allows you to store names and telephone numbers in its memory even when the power is turned off.

Use the following menu to erase the memory if you give the product to someone else or dispose of it.

Color 2.5-inch display models:
Press \( \text{Cancel} \) and select *Restore Default Settings > All Settings.*

Monochrome 2-line display models:
Press \( \text{Cancel} \) and select *Restore Default Settings > Reset All Settings.*
# Getting to Know Your Product

## Available Features

Check what is available for your product.

<table>
<thead>
<tr>
<th></th>
<th>WF-2510 WF-2511</th>
<th>WF-2520 WF-2521 WF-2528</th>
<th>WF-2530 WF-2531 WF-2538</th>
<th>WF-2540 WF-2541 WF-2548</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Copy</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Scan</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Fax</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>ADF</td>
<td>-</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>✓</td>
<td>-</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Ethernet</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>✓</td>
</tr>
<tr>
<td>USB port for a USB flash drive</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>✓</td>
</tr>
</tbody>
</table>

*Note:* The illustrations in this manual are from a similar product model. Although they may differ from your actual product, the method of operation is the same.

## Product Parts

- **a.** ADF cover
- **b.** Automatic Document Feeder (ADF)
- **c.** Edge guide
- **d.**
- **e.**
Getting to Know Your Product

d. ADF input tray (place your originals here to be copied)*
e. ADF output tray (your originals are ejected here as they are copied)*

* The availability of this part varies by product.

a. Edge guide
b. Rear paper feed
c. Paper support extension
d. Paper support
e. Feeder guard
f. Output tray
g. Stopper

a. Document cover
b. Scanner glass
c. Control panel
d. USB connector for a USB flash drive*

* The availability of this part varies by product.
Getting to Know Your Product

Guide to the Control Panel

Note:
Although the control panel design and menu and option names and other items in the LCD display may slightly differ from the actual product, the method of operation is the same.
### Buttons and LCD

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>a</strong></td>
<td><img src="image" alt="Power button" /></td>
</tr>
<tr>
<td><strong>b</strong></td>
<td><img src="image" alt="Copy button" /></td>
</tr>
<tr>
<td><strong>c</strong></td>
<td><img src="image" alt="Fax button" /></td>
</tr>
<tr>
<td><strong>d</strong></td>
<td><img src="image" alt="Scan button" /></td>
</tr>
<tr>
<td><strong>e</strong></td>
<td><img src="image" alt="LCD screen" /></td>
</tr>
<tr>
<td><strong>f</strong></td>
<td><img src="image" alt="LCD screen" /></td>
</tr>
</tbody>
</table>
| **g** | ![Menu and Backspace buttons](image) | Press 
\[left, right, up, down\] to select menus. Press OK to confirm the setting you have selected and go to next screen. When typing a fax number, \[left\] acts as a backspace key, and \[right\] inserts a space. |
| **h** | 0-9,*,# | Specifies the date/time or the number of copies, as well as fax numbers. Enters alphanumeric characters and switches between uppercase, lowercase, and numbers each time it is pressed. Press 1 symb to enter symbols such as the sharp sign (#), plus (+), and apostrophe (’). |
| **i** | ![Speed Dial and Group Dial buttons](image) | Displays speed dial/group dial lists. Press again to switch lists. |
| **j** | ![Last Number button](image) | Displays the last number dialed. When entering numbers in fax mode, this inserts a pause symbol (-) that acts as a brief pause during dialing. |
| **k** | ![Reset button](image) | Stops the ongoing operation or initialize the current settings. If this button is pressed to cancel copying, scanning, or faxing while the ADF is in use, all originals in the ADF will be fed out. |
| **l** | ![Detailed Settings button](image) | Displays detailed settings for each mode. |
### Buttons

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>Cancels/returns to the previous menu.</td>
</tr>
<tr>
<td>n</td>
<td>Provided with Wi-Fi-capable models only. Displays the <strong>Wi-Fi Setup</strong> menus that allow you to set up the product wirelessly. For instructions on using the menus, see the Network Guide.</td>
</tr>
<tr>
<td>o</td>
<td>Start copying/scanning/faxing in black and white.</td>
</tr>
<tr>
<td>p</td>
<td>Start copying/scanning/faxing in color.</td>
</tr>
</tbody>
</table>

Display on the color 2.5-inch display. Indicates the status as follows.
- **Green:** Epson Connect services are online.
- **Red:** Epson Connect services are suspended.
- **Gray:** Epson Connect services are unavailable.

*“Using Epson Connect Service” on page 9*

### Lights

<table>
<thead>
<tr>
<th>Lights</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="on.png" alt="Power" /></td>
<td>On when the product is on. Flashes when the product is receiving data, printing/copying/scanning/faxing, replacing an ink cartridge, charging ink, or cleaning the print head.</td>
</tr>
<tr>
<td><img src="on.png" alt="Wi-Fi" /></td>
<td>Stays on while the product is connected to a Wi-Fi network. Flashes while the Wi-Fi network settings are being made.* This light turns off in sleep mode.</td>
</tr>
<tr>
<td>ADF</td>
<td>On when originals are detected in the ADF.*</td>
</tr>
</tbody>
</table>

* The availability of this part varies by product.
Paper and Media Handling

Introduction to Using, Loading, and Storing Media

You can achieve good results with most types of plain paper. However, coated papers provide superior prints because they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet products, and recommends these papers to ensure high-quality results.

When loading special paper distributed by Epson, read the instruction sheets packed with the paper first and keep the following points in mind.

**Note:**
- Load the paper into the rear paper feed printable side up. The printable side is usually whiter or glossier. See the instruction sheets packed with the paper for more information. Some types of paper have cut corners to help identify the correct loading direction.
- If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may cause ink to smear on your prints. Do not use the paper that is folded, wavy or torn.

Storing paper

Return unused paper to the original package as soon as you finish printing. When handling special media, Epson recommends storing your prints in a resealable plastic bag. Keep unused paper and prints away from high temperature, humidity, and direct sunlight.

Selecting Paper

The table below lists supported papers. Loading capacity and borderless print availability varies by paper as shown.
<table>
<thead>
<tr>
<th>Media Type</th>
<th>Size</th>
<th>Loading capacity (sheets)</th>
<th>Borderless printing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper*1</td>
<td>Letter*2</td>
<td>up to 11mm</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>A4*2</td>
<td>up to 11mm</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>B5*2</td>
<td>up to 11mm</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>A5*2</td>
<td>up to 11mm</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>A6*2</td>
<td>up to 11mm</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Legal</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>User Defined</td>
<td>1</td>
<td>-</td>
</tr>
<tr>
<td>Envelope</td>
<td>#10</td>
<td>10</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>DL</td>
<td>10</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>C6</td>
<td>10</td>
<td>-</td>
</tr>
<tr>
<td>Epson Bright White Ink Jet Paper</td>
<td>A4*2</td>
<td>80</td>
<td>-</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper</td>
<td>A4</td>
<td>80</td>
<td>-</td>
</tr>
<tr>
<td>Epson Matte Paper - Heavyweight</td>
<td>A4</td>
<td>1</td>
<td>✓</td>
</tr>
<tr>
<td>Epson PhotoPaper</td>
<td>A4</td>
<td>1</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>10 × 15 cm (4 × 6 in.)</td>
<td>1</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>13 × 18 cm (5 × 7 in.)</td>
<td>1</td>
<td>✓</td>
</tr>
<tr>
<td>Epson Premium Glossy PhotoPaper</td>
<td>A4</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>10 × 15 cm (4 × 6 in.)</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>13 × 18 cm (5 × 7 in.)</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>16:9 wide size (102 × 181mm)</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td>Epson Premium Semigloss PhotoPaper</td>
<td>A4</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>10 × 15 cm (4 × 6 in.)</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td>Epson Ultra Glossy Photo Paper</td>
<td>A4</td>
<td>1</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>10 × 15 cm (4 × 6 in.)</td>
<td>1</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>13 × 18 cm (5 × 7 in.)</td>
<td>1</td>
<td>✓</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>A4</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>10 × 15 cm (4 × 6 in.)</td>
<td>20</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>13 × 18 cm (5 × 7 in.)</td>
<td>20</td>
<td>✓</td>
</tr>
</tbody>
</table>

*1 Paper with a weight of 64 g/m² (17 lb) to 90 g/m² (24 lb).
*2 The loading capacity for manual 2-sided printing is 30 sheets.
Note:
The availability of paper varies by location.

Paper type settings on the LCD screen

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage accordingly. The table below lists the settings you should choose for your paper.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>LCD paper type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Ink Jet Paper</td>
<td>Epson Bright White Ink Jet Paper</td>
</tr>
<tr>
<td>Epson Ultra Glossy Photo Paper</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper</td>
<td>Epson Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper</td>
<td>Epson Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper</td>
<td>Epson Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper</td>
<td>Epson Photo</td>
</tr>
</tbody>
</table>

Paper type settings from the printer driver

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage accordingly. The table below lists the settings you should choose for your paper.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Printer driver paper type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper*</td>
<td>plain papers</td>
</tr>
<tr>
<td>Epson Bright White Ink Jet Paper*</td>
<td>Epson Bright White Ink Jet Paper*</td>
</tr>
<tr>
<td>Epson Ultra Glossy Photo Paper*</td>
<td>Epson Ultra Glossy</td>
</tr>
<tr>
<td>Epson Premium Glossy Photo Paper*</td>
<td>Epson Premium Glossy Photo Paper*</td>
</tr>
<tr>
<td>Epson Premium Semigloss Photo Paper*</td>
<td>Epson Premium Semigloss Photo Paper*</td>
</tr>
<tr>
<td>Epson Glossy Photo Paper*</td>
<td>Epson Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper*</td>
<td>Epson Photo</td>
</tr>
<tr>
<td>Epson Matte Paper – Heavyweight*</td>
<td>Epson Matte</td>
</tr>
<tr>
<td>Epson Photo Quality Ink Jet Paper*</td>
<td>Epson Photo Quality Ink Jet Paper*</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>

* These paper types are compatible with Exif Print and PRINT Image Matching. For more information, refer to the documentation that came with the Exif Print or PRINT Image Matching compatible digital camera.
Loading Paper and Envelopes

Follow these steps to load paper:

1. Flip the feeder guard forward.

2. Slide out the paper support and the output tray and then raise the stopper.

3. Slide the edge guide to the left.

Note:
The availability of special media varies by location. For the latest information on media available in your area, contact Epson support.

⇒ “Technical Support Web Site” on page 157

Note:
Leave enough space in front of the product for the paper to be fully ejected.
Load paper with the printable side up, against the right side of the rear paper feed.

**Note:**
- Fan and align the edges of the paper before loading.
- The printable side is often whiter or brighter than the other side.
- Always load paper into the rear paper feed short edge first, even when you are printing landscape-oriented pictures.
- You can use the following sizes of paper with binding holes: A4, A5, A6, Legal, Letter. Load only 1 sheet of paper at a time.
- When loading envelopes, load the short edge first with the flap facing down.
- Do not use envelopes that are curled, folded, or glued or that have plastic windows.
- Flatten the envelope and the flaps before loading.
- Flatten the leading edge of the envelope before loading.
- Avoid using envelopes that are too thin, as they may curl during printing.
Slide the edge guide against the left edge of the paper, but not too tightly.

Note:
For plain paper, do not load paper above the \( \Rightarrow \) arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
→ "Selecting Paper" on page 19

Flip the feeder guard back.

Placing Originals

Automatic Document Feeder (ADF)

The availability of this part varies by product.

You can load your original documents in the Automatic Document Feeder (ADF) to copy, scan, or fax multiple pages quickly. You can use the following originals in the ADF.

<table>
<thead>
<tr>
<th>Size</th>
<th>A4/Letter/Legal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Weight</td>
<td>64 g/m² to 95 g/m²</td>
</tr>
<tr>
<td>Capacity</td>
<td>30 sheets or 3 mm or less (A4, Letter)/10 sheets (Legal)</td>
</tr>
</tbody>
</table>
**Important:**
To prevent paper jams, avoid the following documents. For these types, use the scanner glass.

- Documents held together with paper clips, staples, etc.
- Documents that have tape or paper stuck to them.
- Photos, OHPs, or thermal transfer paper.
- Paper that is torn, wrinkled, or has holes.

1. Make sure that there are no originals on the scanner glass. The ADF may not detect documents in the feeder if there are originals on the scanner glass.

2. Tap the originals on a flat surface to even the edges.


4. Insert the originals face-up and short edge first into the Automatic Document Feeder.
5 Slide the edge guide until it is flush with the originals.

6 Check that the ADF light in the control panel is on.

**Note:**
- The ADF light may stay off if there is any other original on the scanner glass. If you press \( \Phi \) in this case, the original on the scanner glass will be copied, scanned, or faxed instead of the originals in the ADF.
- The ADF light will not turn on when the product is in sleep mode. Press any button other than \( \Theta \) to recover from sleep mode. It may take some time for the light to turn on after recovery from sleep mode.
- Be careful not to let any foreign object get inside the hole on the left front corner of the scanner glass. Doing so may prevent the ADF from operating.
- When you use the copy function with the Automatic Document Feeder (ADF), the print settings are fixed at Reduce/Enlarge - Actual Size, Paper Type - Plain Paper, and Paper Size - A4/Legal. The print is cropped if you copy an original larger than A4/Legal.

---

**Scanner glass**

1 Open the document cover and place your original face-down on the scanner glass.
2 Slide the original to the corner.

Note:
See the following sections if any problems occur with the scanning area or the scanning direction when using EPSON Scan.
- “The edges of your original are not scanned” on page 142
- “Multiple documents are scanned into a single file” on page 143

3 Close the cover gently.
Copying

Copying Documents

Basic copying

Follow the steps below to copy documents.

1. Load paper. ➤ "Loading Paper and Envelopes" on page 22

2. Place your original(s) in the Automatic Document Feeder or on the scanner glass. ➤ "Placing Originals" on page 24

3. Press ◀ to enter the copy mode.

4. Press ▲ or ▼ to set the number of copies. The density for models with a color 2.5-inch display can be changed if desired.

5. Display the copy setting menus.
   
   Color 2.5-inch display models: Press ◄ and select Paper and Copy Settings.
   
   Monochrome 2-line display models: Press ◄.

6. Select the appropriate copy settings such as layout, paper size, paper type, and paper quality. Use ▲ or ▼ to select a setting item and then press OK. When finished, press ◄ again to return to the copy mode top screen.

7. Press one of the ◆ buttons to start copying.

Copy Mode Menu List

Refer to the section below for the Copy mode menu list. ➤ "Copy Mode" on page 79
Printing

Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results. The status monitor and the printer utilities help you check the product and keep it in top operating condition.

Note for Windows users:

❏ Your printer driver automatically finds and installs the latest version of the printer driver from Epson’s Web site. Click the Software Update button in your printer driver’s Maintenance window, and then follow the on-screen instructions. If the button does not appear in the Maintenance window, point at All Programs or Programs in the Windows Start menu, and check in the EPSON folder.

❏ If you want to change the language of the driver, select the language you want to use from the Language setting in your printer driver’s Maintenance window. Depending on the location, this function may not be available.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the Windows Start menu, or the taskbar.

To make settings that apply only to the application you are using, access the printer driver from that application.

To make settings that apply to all of your Windows applications, access the printer driver from the Start menu or the taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows 7.

From Windows applications

1 Click Print or Print Setup on the File menu.

2 In the window that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on your application, you may need to click one or a combination of these buttons.)

From the Start menu

Windows 7:
Click the start button, select Devices and Printers. Then right-click the product and select Printing preferences.

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category. Then select the product and then click Select printing preferences.
Windows XP:
Click Start, Control Panel, (Printers and Other Hardware,) then Printers and Faxes. Select the product, then click Printing Preferences on the File menu.

From the shortcut icon on the taskbar
Right-click the product icon on the taskbar, then select Printer Settings.

To add a shortcut icon to the Windows taskbar, first access the printer driver from the Start menu as described above. Next, click the Maintenance tab, and then the Monitoring Preferences button. In the Monitoring Preferences window, select the Shortcut Icon check box.

Getting information through online help
In the printer driver window, try one of the following procedures.

- Right-click the item, then click Help.
- Click the button at the top right of the window, then click the item (for Windows XP only).

Accessing the printer driver for Mac OS X
The table below describes how to access the printer driver dialog.

<table>
<thead>
<tr>
<th>Dialog Box</th>
<th>How to Access It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup</td>
<td>Click Page Setup on the File menu of your application. Note: Depending on your application, the Page Setup menu may not appear in the File menu.</td>
</tr>
<tr>
<td>Print</td>
<td>Click Print on the File menu of your application.</td>
</tr>
<tr>
<td>Epson Printer Utility 4</td>
<td>For Mac OS X 10.7, click System Preferences on the Apple menu and then click Print &amp; Scan. Select your product from the Printers list box, click Options &amp; Supplies, Utility, and then click Open Printer Utility. For Mac OS X 10.6, click System Preferences on the Apple menu and then click Print &amp; Fax. Select your product from the Printers list box, click Options &amp; Supplies, Utility, and then click Open Printer Utility. For Mac OS X 10.5, click System Preferences on the Apple menu and then click Print &amp; Fax. Select your product from the Printers list box, click Open Print Queue and then click Utility button.</td>
</tr>
</tbody>
</table>

Getting information through online help
Click the Help button in the Print dialog box.
Basic Operations

Basic printing

Note:
- The screen shots in this section may vary depending on the model.
- Before you print, load paper properly.
  ➤ “Loading Paper and Envelopes” on page 22
- Refer to the section below for the printable area.
  ➤ “Printable area” on page 148
- After completing the settings, print one test copy and examine the results before printing an entire job.

Basic product settings for Windows

1. Open the file you want to print.

2. Access the printer settings.
  ➤ “Accessing the printer driver for Windows” on page 29

3. Click the Main tab.

4. Select the appropriate Document Size setting. You can also define a custom paper size. For details, see the online help.
5 Check **Borderless** to print borderless photos.
⇒ “Selecting Paper” on page 19

If you want to control the amount of the image that extends beyond the edges of the paper, click the **Settings** button, select **Auto Expand** as the Method of Enlargement, and then adjust the **Amount of Enlargement** slider.

6 Select **Portrait** (tall) or **Landscape** (wide) to change the orientation of your print.

**Note:**
Select **Landscape** when printing on envelopes.

7 Select the appropriate **Paper Type** setting.
⇒ “Paper type settings from the printer driver” on page 21

**Note:**
Print quality is automatically adjusted for the selected **Paper Type**.

8 Click **OK** to close the printer settings window.

**Note:**
To make changes to advanced settings, refer to the relevant section.

9 Print your file.

**Basic product settings for Mac OS X**

**Note:**
Screen shots of the printer driver windows in this section are from Mac OS X 10.7.

1 Open the file you want to print.
Access the Print dialog box.

“Accessing the printer driver for Mac OS X” on page 30

Note:
If the simplified status monitor is displayed, click the Show Details button (for Mac OS X 10.7) or the ▼ button (for Mac OS X 10.6 or 10.5) to extend this dialog box.

Select the product you are using as the Printer setting.

Note:
Depending on your application, you may not be able to select some of the items in this dialog box. If so, click Page Setup on the File menu of your application, and then make suitable settings.

Select the appropriate Paper Size setting.

Note:
Select XXX (Borderless) as the Paper Size if you want to print borderless photos.

“Selecting Paper” on page 19

Select the appropriate Orientation setting.

Note:
Select landscape orientation when printing envelopes.
Select Print Settings from the pop-up menu.

Select the appropriate Media Type setting.

Select the appropriate Expansion setting during borderless printing to control the amount of the image that extends beyond the edges of the paper.

Click Print to start printing.

Canceling printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the product button

Press to cancel a print job in progress.

For Windows

Note: You cannot cancel a print job that has been completely sent to the product. In this case, cancel the print job by using the product.
Access the EPSON Status Monitor 3.
   ➪ “For Windows” on page 121

Click the Print Queue button. The Windows Spooler appears.

Right-click on the job you want to cancel and then select Cancel.

**For Mac OS X**

Follow the steps below to cancel a print job.

1. Click your product icon in the Dock.

2. In the Document Name list, select the document which is printing.

3. Click the Delete button to cancel the print job.

**Other Options**

**Printing photos the easy way**
Epson Easy Photo Print lets you lay out and print digital images on various types of paper. The step-by-step instructions in the window let you preview the printed images and get the effects you want without having to make any difficult settings.

Using the Quick Print function, you can perform one-click printing with the settings you make.

**Starting Epson Easy Photo Print**

*For Windows*

- Double-click the **Epson Easy Photo Print** icon on the desktop.

- **For Windows 7 and Vista:**
  - Click the start button, point to **All Programs**, click **Epson Software**, and then click **Easy Photo Print**.

- **For Windows XP:**
  - Click **Start**, point to **All Programs**, point to **Epson Software**, then click **Easy Photo Print**.

*For Mac OS X*

Double-click the **Applications** folder on your Mac OS X hard drive, then double-click in turn on the **Epson Software** and **Easy Photo Print** folders and finally double-click the **Easy Photo Print** icon.

**Product presets (For Windows Only)**

Printer driver presets make printing a snap. You can also create presets of your own.

**Product settings for Windows**

1. Access the printer settings.
   - ➤ “Accessing the printer driver for Windows” on page 29

2. Select a Printing Presets in the Main tab. Product settings are automatically set to the values displayed in the pop-up window.

**2-sided printing (for Windows only)**

Use the printer driver to print on both sides of the paper.

Two types of 2-sided printing are available: standard and folded booklet.
2-sided printing is only available for the following papers and sizes.

<table>
<thead>
<tr>
<th>Paper</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Legal, Letter, A4, B5, A5, A6</td>
</tr>
<tr>
<td>Epson Bright White Ink Jet Paper</td>
<td>A4</td>
</tr>
</tbody>
</table>

**Note:**
- This feature is not available for Mac OS X.
- This feature may not be available at some settings.
- This feature may not be available when the product is accessed over a network or is used as a shared printer.
- The loading capacity differs during 2-sided printing.
  ➔ "Selecting Paper" on page 19
- Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may deteriorate.
- Depending on the paper and the amount of ink used to print text and images, ink may bleed through to the other side of the paper.
- The surface of the paper may be smeared during 2-sided printing.
- This feature is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

**Product settings for Windows**

1. Access the printer settings.
   ➔ “Accessing the printer driver for Windows” on page 29

2. Select 2-Sided Printing check box.

3. Click Settings, and make the appropriate settings.

   **Note:**
   If you want to print a folded booklet, select Booklet.

4. Check the other settings and print.

   **Note:**
   - The actual binding margin may be different from the specified settings depending on your application.
   - Experiment with a few sheets to examine actual results before printing the entire job.
   - Make sure that the ink is completely dry before reloading the paper.
Fit to page printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer driver.

*Note:*  
This feature may not be available at some settings.

Product settings for Windows

1. Access the printer settings.  
   ➔ “Accessing the printer driver for Windows” on page 29
2. Select **Reduce/Enlarge Document** and **Fit to Page** in the More Options tab, and then select the size of the paper you are using from **Output Paper**.
3. Check the other settings and print.

Product settings for Mac OS X

1. Access the Print dialog box.  
   ➔ “Accessing the printer driver for Mac OS X” on page 30
2. Choose **Scale to fit paper size** for **Destination Paper Size** in the Paper Handling pane and select the desired paper size from the pop-up menu.
3. Check the other settings and print.
Pages per sheet printing

Lets you use the printer driver to print two or four pages on a single sheet of paper.

**Note:**
*This feature may not be available at some settings.*

**Product settings for Windows**

1. Access the printer settings.
   ➤ “Accessing the printer driver for Windows” on page 29
2. Select 2-Up or 4-Up as Multi-Page in the Main tab.
3. Click Page Order, and make the appropriate settings.
4. Check the other settings and print.

**Product settings for Mac OS X**

1. Access the Print dialog box.
   ➤ “Accessing the printer driver for Mac OS X” on page 30
2. Select the desired number of Pages per Sheet and the Layout Direction (page order) in the Layout pane.
3. Check the other settings and print.
Sharing the Product for Printing

Setup for Windows

These instructions tell you how to set up your product so other users on the network can share it.

First you will set up the product as a shared printer on the computer directly connected to it. Then you will add the product to each network computer that will access it.

Note:
- These instructions are for small networks only. To share the product on a large network, consult your network administrator.
- The screen shots in the following section are from Windows 7.

Setting up the product as a shared printer

Note:
- To set up the product as a shared printer in Windows 7 or Vista, you will need an account with administrator privileges and the password if you log on as a standard user.
- To set up the product as a shared printer in Windows XP, you must log on to a Computer Administrator account.

Follow the steps below on the computer that is connected directly to the product:

1. Windows 7:
   Click the start button, select Devices and Printers.

   Windows Vista:
   Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

   Windows XP:
   Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other Hardware category.

2. Windows 7:
   Right-click the icon for your product, click Printer properties, and then click Sharing. Then click the Change Sharing Options button.

   Windows Vista:
   Right-click the icon for your product, and then click Sharing. Click the Change sharing options button and then click Continue.

   Windows XP:
   Right-click the icon for your product, then click Sharing.

3. Select Share this printer, then type a Share name.

Note:
Do not use spaces or hyphens in the share name.
If you want to automatically download printer drivers for computers that are running different versions of Windows, click **Additional Drivers** and select the environment and the operating systems of the other computers. Click **OK**, then insert the product software disk.

4. Click **OK** or **Close** (if you installed additional drivers).

**Adding the product to the other network computers**

Follow these steps to add the product to each network computer that will access it.

**Note:**
Your product must be set up as a shared printer on the computer to which it is connected before you can access it from another computer.

⇒ "Setting up the product as a shared printer" on page 40.

1. **Windows 7:**
   Click the start button, select **Devices and Printers**.

   **Windows Vista:**
   Click the start button, select **Control Panel**, and then select **Printer** from the **Hardware and Sound** category.

   **Windows XP:**
   Click **Start** and select **Control Panel**, and then select **Printers and Faxes**, from the **Printers and Other Hardware** category.
2 **Windows 7 and Vista:**  
Click the **Add a printer** button.

**Windows XP:**  
Click the **Add a printer** button. The Add Printer Wizard appears. Click the **Next** button.

3 **Windows 7 and Vista:**  
Click **Add a network, wireless or Bluetooth printer**, and then click **Next**.

**Windows XP:**  
Select **A network printer, or a printer attached to another computer**, then click **Next**.

![Add Printer Wizard](image)

4 Follow the on-screen instructions to select the product you want to use.

**Note:**  
Depending on the operating system and the configuration of the computer to which the product is connected, the Add Printer Wizard may prompt you to install the printer driver from the product software disk. Click the **Have Disk** button and follow the on-screen instructions.

---

**Setup for Mac OS X**

To set up your product on a Mac OS X network, use the Printer Sharing setting. See your Macintosh documentation for details.
Let’s Try Scanning

Starting a Scan

Let’s scan a document to get used to the process.

1. Place your original(s) on the scanner glass.
   ➤ "Placing Originals” on page 24

2. Start Epson Scan.
   - Windows: Double-click the Epson Scan icon on the desktop.
   - Mac OS X: Select Applications > Epson Software > EPSON Scan.

3. Select Home Mode.
Scanning

4. Select **Text/Line Art** as the **Document Type** setting.

5. Click **Preview**.

6. Click **Scan**.
Click OK.

Your scanned image is saved.

**Image Adjustment Features**

Epson Scan offers a variety of settings for improving color, sharpness, contrast, and other aspects affecting image quality.

See the Help for more details on Epson Scan.
### Scanning

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tone Correction</td>
<td>Provides a graphical interface for adjusting tone levels individually.</td>
</tr>
<tr>
<td>Image Adjustment</td>
<td>Adjusts brightness and contrast and the balance of red, green, and blue colors in the overall image.</td>
</tr>
<tr>
<td>Color Palette</td>
<td>Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the highlight and shadow areas of the image.</td>
</tr>
<tr>
<td>Unsharp Mask</td>
<td>Sharpens the edges of image areas for an overall clearer image.</td>
</tr>
<tr>
<td>Descreening</td>
<td>Removes rippled patterns (known as moiré) that can appear in subtly shaded image areas such as skin tones.</td>
</tr>
<tr>
<td>Color Restoration</td>
<td>Restores the colors in faded photos automatically.</td>
</tr>
</tbody>
</table>
### Basic Scanning from the Control Panel

You can scan documents and send the scanned image from the product to a connected computer. Make sure you have installed software for the product on your computer and connected to the computer.

1. Place your original(s) in the Automatic Document Feeder or on the scanner glass.
   
   ➤ “Placing Originals” on page 24
Press 📦 to enter the scan mode.

Select a scan menu item. Use ▲ or ▼ to select a menu, and press OK.

“Scan Mode” on page 87

Select your computer.

Note:
- If the product is connected to a network, you can select the computer to which you want to save the scanned image.
- You can change the computer name displayed on the control panel using Epson Event Manager.

Color 2.5-inch display models:
To store the scanned image on a USB flash drive connected to the product, select Scan to USB Device. For information on Scan to Cloud, see the Epson Connect guide, which can be accessed using the 🔄 shortcut icon on the desktop.

Start scanning.
Color 2.5-inch display models:
Press φ.

Monochrome 2-line display models:
Press OK.

Your scanned image is saved.

Scan mode menu list

Refer to the section below for the Scan mode menu list.
“Scan Mode” on page 87

Basic Scanning from Your Computer

Scanning in Home Mode

Home Mode lets you customize some scanning settings and check the changes you have made in a preview image. This mode is useful for basic scanning of photos and graphics.

Note:
- In Home Mode, you can only scan from the scanner glass.
- See the Help for more details on Epson Scan.

Place your original(s).
“Scanner glass” on page 26
Start Epson Scan.  
⇒ "Starting Epson Scan Driver" on page 61

Select Home Mode from the Mode list.

Select the Document Type setting.

Select the Image Type setting.

Click Preview.  
⇒ "Previewing and Adjusting the Scan Area" on page 54

Adjust the exposure, brightness, and other image quality settings.

Click Scan.
In the File Save Settings window, select the Type setting and then click **OK**.

**Note:**
*If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without displaying the File Save Settings window.*

Your scanned image is saved.

### Scanning in Office Mode

Office Mode lets you quickly scan text documents without previewing your image.

**Note:**
*See the Help for more details on Epson Scan.*

1. Place your original(s).
   
   &gt; “Placing Originals” on page 24

   **Note for the Automatic Document Feeder (ADF):**
   
   - If you are using preview function, load only the first page.
   - Do not load paper above the line just under the ▼ arrow mark on the ADF.

2. Start Epson Scan.
   
   &gt; “Starting Epson Scan Driver” on page 61
Select **Office Mode** from the Mode list.

Select the **Image Type** setting.

Select the **Document Source** setting.

Select the size of your original as the **Size** setting.

Select an appropriate resolution for your original(s) as the **Resolution** setting.

Click **Scan**.
In the File Save Settings window, select the Type setting and then click **OK**.

**Note:**
If the **Show this dialog box before next scan** check box is cleared, Epson Scan starts scanning immediately without displaying the File Save Settings window.

Your scanned image is saved.

### Scanning in Professional Mode

Professional Mode gives you total control of your scanning settings and lets you check the changes you have made in a preview image. This mode is recommended for advanced users.

**Note:**
See the Help for more details on Epson Scan.

1. Place your original(s).
   ➤ “Placing Originals” on page 24

   **Note for the Automatic Document Feeder (ADF):**
   If you are using preview function, load only the first page.

2. Start Epson Scan.
   ➤ “Starting Epson Scan Driver” on page 61
Select **Professional Mode** from the Mode list.

Select the type of original(s) you are scanning as the Document Type setting.

Select the Document Source setting.

If you select **Reflective** as the Document Type setting, select **Photo** or **Document** as the Auto Exposure Type setting.
Select the Image Type setting.

Select an appropriate resolution for your original(s) as the Resolution setting.

Click Preview to preview your image(s). The Preview window opens and displays your image(s).

---

**Note for the Automatic Document Feeder (ADF):**
- The ADF loads your first document page, and then Epson Scan prescans it and displays it in the Preview window. The ADF then ejects your first page.
- Place your first document page on top of the rest of the pages, and then load the entire document into the ADF.
- Do not load paper above the line just under the ▼ arrow mark on the ADF.

---

Select the size of the scanned image(s) as the Target Size setting if necessary. You can scan your images at their original size, or you can reduce or enlarge their size by selecting Target Size.

Adjust the image quality if necessary.

---

Select the size of the scanned image(s) as the Target Size setting if necessary. You can scan your images at their original size, or you can reduce or enlarge their size by selecting Target Size.

---

Click Scan.

In the File Save Settings window, select the Type setting and then click OK.

---

**Note:**
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without displaying the File Save Settings window.

Your scanned image is saved.

---

**Previewing and Adjusting the Scan Area**

**Selecting a preview mode**

Once you have selected your basic settings and resolution, you can preview your image and select or adjust the image area in a Preview window. There are two types of preview.

- Normal preview displays your previewed image(s) in their entirety. You can select the scan area and make any image quality adjustments manually.

- Thumbnail preview displays your previewed image(s) as thumbnail(s). Epson Scan automatically locates the edges of your scan area, applies automatic exposure settings to the image(s), and rotates the image(s) if necessary.
Creating a marquee

A marquee is a moving dotted line that appears on the edges of your preview image to indicate the scan area.

Do one of the following to draw a marquee.

- To draw the marquee manually, position the pointer in the area where you want to place the corner of your marquee and click. Drag the cross-hairs over the image to the opposite corner of the desired scan area.

- To draw the marquee automatically, click the auto locate icon. You can only use this icon when you are viewing a normal preview and you only have one document on the scanner glass.

- To draw the marquee at a specified size, type in a new width and height in the Document Size setting.

- For best results and image exposure, make sure all sides of the marquee are located inside the preview image. Do not include any areas around the preview image in the marquee.

Adjusting a marquee

You can move the marquee and adjust its size. If you are viewing a normal preview, you can create multiple marquees (up to 50) on each image to scan different image areas as separate scan files.

<table>
<thead>
<tr>
<th></th>
<th>To move the marquee, position your cursor inside the marquee. The pointer becomes a hand. Click and drag the marquee to the desired location.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To resize the marquee, position your cursor over the edge or corner of the marquee. The pointer becomes a straight or angled double-arrow. Click and drag the edge or corner to the desired size.</td>
</tr>
</tbody>
</table>
Various Types of Scanning

Scanning a Magazine

First of all, place your magazine and start Epson Scan.

1 Select **Home Mode** from the Mode list.

   "Starting a Scan" on page 43
Select **Magazine** as the Document Type setting.

Click **Preview**.

Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

Click **Scan**.

Select **PDF** as the Type setting, and then click **OK**.

Your scanned image is saved.

---

### Scanning Multiple Documents to a PDF File

First of all, place your document and start Epson Scan.

➤ "Starting a Scan" on page 43

---

**Note for the Automatic Document Feeder (ADF):**

If you are using preview function, load only the first page.
1 Select **Professional Mode** from the Mode list.

2 Select the Document Source setting.

3 Click **Preview**.

**Note for the Automatic Document Feeder (ADF):**
- The document page ejected by the ADF has not been scanned yet. Reload the entire document into the ADF.
- Do not load paper above the line just under the ▼ arrow mark on the ADF.
4 Adjust the exposure, brightness, and other image quality settings.
See the Help for more details on Epson Scan.

5 Click Scan.

6 Select PDF as the Type setting, and then click OK.

Note:
If the Show Add Page dialog after scanning check box is cleared, Epson Scan automatically saves your document without displaying the Add Page Confirmation window.

7 Epson Scan starts scanning your document.

8 If you want to scan more pages, click Add page.
Load the document and scan again, repeating as necessary for each page.

If you have finished scanning, go to step 9.
Click **Edit page** or **Save File**.

<table>
<thead>
<tr>
<th>Edit page</th>
<th>Select this button if you want to delete or reorder any of the pages. Then use the icons on the bottom of the Editing Page window to select, rotate, reorder, and delete pages. See the Help for more details on Epson Scan.</th>
</tr>
</thead>
</table>

Click **OK** when you are finished editing your pages.

<table>
<thead>
<tr>
<th>Save File</th>
<th>Select this button when you are finished.</th>
</tr>
</thead>
</table>

The pages are saved in one PDF file.

## Scanning a Photo

First of all, place your photo on the scanner glass and start Epson Scan.

⇒ "Starting a Scan" on page 43
Select **Home Mode** from the Mode list.

Select **Photograph** as the Document Type setting.

Click **Preview**.

Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

Click **Scan**.

Select **JPEG** as the Type setting, and then click **OK**.

Your scanned image is saved.

**Software Information**

**Starting Epson Scan Driver**

This software lets you control all aspects of scanning. You can use this as a standalone scanning program or use it with another TWAIN-compliant scanning program.
How to start

Windows:
Double-click the EPSON Scan icon on the desktop.
Or, select the start button icon or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON Scan.

Mac OS X:
Select Applications > Epson Software > EPSON Scan.

How to access the help

Click the Help button on the Epson Scan driver.

Starting Other Scanning Software

Note:
Some scanning software may not be included in some countries.

Epson Event Manager

This lets you assign any of the product buttons to open a scanning program. You can also save frequently used scanning settings, which can really speed up your scanning projects.

How to start

Windows:
Select the start button or Start > All Programs or Programs > Epson Software > Event Manager.

Mac OS X:
Select Applications > Epson Software, and then double-click the Launch Event Manager icon.

How to access the help

Windows:
Click the icon in the upper right corner of the screen.

Mac OS X:
Click menu > Help > Epson Event Manager Help.

ABBYY FineReader

This software lets you scan a document and convert the text into data that you can edit with a word processing program.

OCR software cannot recognize, or has difficulty recognizing, the following types of documents or text.

- Handwritten characters
- Items that have been copied from other copies
- Faxes
Scanning

- Text with tightly spaced characters or line pitch
- Text that is in tables or underlined
- Cursive or italic fonts, and font sizes less than 8 points
- Folded or wrinkled documents

See the ABBYY FineReader help for more details.

How to start

- Windows:
  Select the start button or Start > All Programs or Programs > ABBYY FineReader folder > ABBYY FineReader.

- Mac OS X:
  Select Applications, and then double-click ABBYY FineReader.

Presto! PageManager

This software lets you scan, manage, and share your photos or documents.

How to start

- Windows:
  Select the start button or Start > All Programs or Programs > Presto! PageManager folder > Presto! PageManager.

- Mac OS X:
  Select Application > Presto! PageManager, and then double-click the Presto! PageManager icon.
Faxing

Introducing FAX Utility

FAX Utility is a software capable of transmitting data such as documents, drawings, and tables created using a word processing or spreadsheet application directly by fax, without printing. Use the following procedure to run the utility.

**Windows**
Click the start button (Windows 7 and Vista) or click **Start** (Windows XP), point to **All Programs**, select **Epson Software**, and then click **FAX Utility**.

**Mac OS X**
Click **System Preference**, click **Print & Fax** or **Print & Scan**, and then select **FAX** (your product) from **Printer**. Then click as follows;
Mac OS X 10.6.x, 10.7.x: **Option & Supplies - Utility - Open Printer Utility**
Mac OS X 10.5.x: **Open Print Queue - Utility**

**Note:**
For more details, see the online help for FAX Utility.

Connecting to a Phone Line

About a phone cable

Use a phone cable with the following interface specification.

- RJ-11 Phone Line
- RJ-11 Telephone set connection

Depending on the area, a phone cable may be included with the product. If so, use that cable.
Using the phone line for fax only

1 Connect a phone cable leading from a telephone wall jack to the LINE port.

2 Make sure Auto Answer is set to On.

   “Setting up to receive faxes automatically” on page 75

Important:
If you do not connect an external telephone to the product, make sure you turn on auto answer. Otherwise, you cannot receive faxes.

Sharing line with phone device

1 Connect a phone cable leading from a telephone wall jack to the LINE port.

2 Remove the cap.
Faxing

3 Connect a phone or answering machine to the EXT. port.

Note:
- See the following for other connection methods.
- For details, see the documentation that came with your devices.

Connecting to DSL

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Telephone wall jack</td>
</tr>
<tr>
<td>b</td>
<td>Splitter</td>
</tr>
<tr>
<td>c</td>
<td>DSL modem</td>
</tr>
</tbody>
</table>
Connecting to ISDN (one phone number)

Connecting to ISDN (two phone numbers)

Checking the fax connection

You can check whether the product is ready to send or receive faxes.

1 Load plain paper.
   ⇒ “Loading Paper and Envelopes” on page 22

2 Press to enter the fax mode.

3 Press to display the menus.
Faxing

4. Select Fax Settings > Check Fax Connection. Use ▲ or ▼ to select a menu, and press OK.

5. Press one of the ◇ buttons to print the report.

Note:
If an errors are reported, try the solutions in the report.

Notices when the power is turned off

When the product is turned off, the following data stored in the product’s temporary memory is erased.

- Received fax data
- Fax data scheduled to be sent later
- Fax data being transmitted automatically

Also, when the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn the power back on.

If the product is turned off due to a power failure, it automatically restarts and beeps when the power is restored. If you have set to receive faxes automatically (Auto Answer - On), the setting is also restored. Depending on the circumstances before the power failure, it may not restart.

Setting Up Fax Features

Setting up speed dial entries

You can create a speed dial list allowing you to select fax recipient numbers quickly when faxing. Up to 60 combined speed dial and group dial entries can be registered.

1. Press ◇ to enter the fax mode.

2. Press • to display the menus.

3. Select the menu shown below. Use ▲ or ▼ to select a menu, and press OK.

   Color 2.5-inch display models:
   Select Speed Dial Setup.

   Monochrome 2-line display models:
   Select Fax Settings > Speed Dial Setup.

4. Select Create. You see the available speed dial entry numbers.
Select the speed dial entry number that you want to register. Use ▲ or ▼ to select a number, and press OK. You can register up to 60 entries.

Use the numeric keypad to enter a phone number, and press OK. You can enter up to 64 digits.

Note:
- Press ▲ to enter a space. Press ▼ to delete numbers. Press ◄ or ► to enter a hyphen (-).
- A hyphen (“-“) causes a slight pause when dialing. Only include it in phone numbers when a pause is necessary. Spaces entered between numbers are ignored when dialing.

Enter a name to identify the speed dial entry. You can enter up to 30 characters.

Color 2.5-inch display models:
Select Done and press OK to register the name.

Monochrome 2-line display models:
Press OK to register the name.

**Setting up group dial entries**

You can add speed dial entries to a group, allowing you to send a fax to multiple recipients at the same time. Up to 60 combined speed dial and group dial entries can be entered.

1. Press ◇ to enter the fax mode.
2. Press ➔ to display the menus.
3. Select the menu shown below. Use ▲ or ▼ to select a menu, and press OK.

Color 2.5-inch display models:
Select Group Dial Setup.

Monochrome 2-line display models:
Select Fax Settings > Group Dial Setup.

4. Select Create. You see the available group dial entry numbers.
5. Select the group dial entry number that you want to register. Use ▲ or ▼ to select a number, and press OK.
6. Enter a name to identify the group dial entry. You can enter up to 30 characters.

Color 2.5-inch display models:
Select Done and press OK to register the name.

Monochrome 2-line display models:
Press OK to register the name.
Faxing

7 Select a speed dial entry that you want to register in the group dial list. Use ▲ or ▼ to select the entry and do the following to add it to the group.

Color 2.5-inch display models:
Press ▶. When you want to cancel the selection, press ▶ again.

Monochrome 2-line display models:
Press ✗. When you want to cancel the selection, press ✗ again.

8 Repeat step 7 to add other speed dial entries to the group dial list. You can register up to 30 speed dial entries in a group dial.

9 Press OK to finish creating a group dial list.

Creating header information

You can create a fax header by adding information such as your phone number or name.

Note:
Make sure you have set the time correctly.
► “Setting/Changing Time and Region” on page 108

1 Press ◦ to enter the fax mode.

2 Press ⊕ to display the menus.

3 Select the menu shown below. Use ▲ or ▼ to select a menu, and press OK.

Color 2.5-inch display models:
Select Fax Settings > Communication > Header > Fax Header.

Monochrome 2-line display models:
Select Fax Settings > Header > Fax Header.

4 Enter the header information. You can enter up to 40 characters.

Color 2.5-inch display models:
Select Done and press OK to register the name.

Monochrome 2-line display models:
Press OK to register the name.

5 Press ▼ to select Your Phone Number and press OK.
Use the numeric keypad with other buttons on the control panel to enter your phone number. You can enter up to 20 digits.

**Note:**
Press the # button to enter a plus sign (+) which represents the international call prefix. Note that the asterisk (*) is unavailable.

Press OK to register the header information.

**Sending Faxes**

**Sending faxes by entering a number**

1. Place your original(s) in the Automatic Document Feeder or on the scanner glass.
   ➤ “Placing Originals” on page 24
2. Press ☑ to enter the fax mode.
3. Use the keys on the numeric keypad to enter the fax number. You can enter up to 64 digits.
   Monochrome 2-line display models:
   If you want to send the fax to more than one recipient, press OK after entering a one fax number, and select Yes to add another fax number.

   **Note:**
   - To display the last fax number you used, press ☑/טר.
   - You can change fax quality and contrast settings. When finished, press ☑ again to return to the fax mode top screen.
     - Color 2.5-inch display models:
       Press ☑ and select **Send Settings** - Quality or Contrast.
     - Monochrome 2-line display models:
       Press ☑ and select **Quality** or **Contrast**.
   - Make sure you have entered the header information. Some fax machines automatically reject incoming faxes that do not include header information.
4. Press one of the ◇ buttons to start sending.

   **Note:**
   If the fax number is busy or there is some problem, this product redials after one minute. Press ☑/טר to redial immediately.

**Sending faxes using speed dial/group dial**

Follow the instructions below to send faxes using speed dial/group dial.
Place your original(s) in the Automatic Document Feeder or on the scanner glass.  
⇒ “Placing Originals” on page 24

Press ☐ to enter the fax mode.

Press ✡/▲.

**Note:**  
Each press of ✡/▲ switches between the speed dial list and group dial list.

Select the entry number to send. Use ▲ or ▼ to select an entry, and press OK.

Monochrome 2-line display models:  
You will be prompted to add another number. You can add another number by manually entering the number or using the speed dial or group dial.

**Note:**  
You can change fax quality and contrast settings. When finished, press ✡ again to return to the fax mode top screen.

Color 2.5-inch display models:  
Press ✡ and select Send Settings - Quality or Contrast.

Monochrome 2-line display models:  
Press ✡ and select Quality or Contrast.

Press one of the ☐ buttons to start sending.

### Sending faxes by broadcasting

Broadcast allows you to easily send the same fax to multiple numbers (up to 30) using speed dial/group dial, or by entering the fax numbers. Follow the instructions below to send faxes by broadcasting.

**Note:**
- This function is available only with color 2.5-inch display models.
- You can only send B&W faxes.

1. Place your original(s) in the Automatic Document Feeder or on the scanner glass.  
   ⇒ “Placing Originals” on page 24
2. Press ☐ to enter the fax mode.
3. Press ✡ to display the menus.
Select **Broadcast Fax**.

*Note:*  
*To select recipients from a speed or group dial list, go to step 7.*

5  
Enter a fax number.

6  
Press ▼ to move to the next line.

*Note:*
- To add another number, repeat steps 5 and 6 or go to step 7.
- If you do not need to add recipients from the speed dial/group dial lists, press **OK** and go to step 10.

7  
Press ➥ to display the speed dial list.

*Note:*
*Each press of ➥ switches between the speed dial list, group dial list and direct input screen.*

8  
Select speed dial or group dial entries to send the fax.

9  
Press **OK**. You see a confirmation message.

10  
Press the ◇ (B&W) button to start sending.

## Sending a fax at a specified time

Follow the instructions below to send a fax at a specified time.

*Note:*
- Make sure you have set the time correctly.  
  ➤ "Setting/Changing Time and Region" on page 108
- You can only send B&W faxes.

1  
Place your original(s) in the Automatic Document Feeder or on the scanner glass.  
➤ “Placing Originals” on page 24

2  
Press ◇ to enter the fax mode.

3  
Enter a fax number. You can also use redial, speed dial, or group dial lists to select fax number.

4  
Press ➥ to display the menus.
Faxing

5 Select Send Fax Later. Use ▲ or ▼ to select the menu, and press OK.

6 Press ▼ to select On.

Monochrome 2-line display models:
Press ► to display the time settings.

7 Set the time that you want to send the fax, and then press OK. Use ► or ◄ to move the cursor and use ▲ or ▼ to select a.m. or p.m.

8 Press ◄ to return to the fax send screen.

9 Press the ◇ (B&W) button to start scanning. The scanned image is sent at the specified time.

Note:
If you need to cancel faxing at the time you specified, press ◇.

Sending a fax from a connected phone

If the recipient has the same number for both phone and fax, you can send a fax after talking over the phone without hanging up.

1 Place your original(s) in the Automatic Document Feeder or on the scanner glass.
   ➤ “Placing Originals” on page 24

2 Dial a number from the phone connected to the product.

3 Select Send on the control panel of the product.

4 Press one of the ◇ buttons to send fax.

5 Hang up the phone.
Receiving Faxes

Setting up to receive faxes automatically

Follow the instructions to make settings to receive faxes automatically.

1. Load plain paper in the rear paper feed.
   ➤ "Loading Paper and Envelopes" on page 22

2. Press \( \text{Hold} \) to enter the fax mode.

3. Press \( \text{Menu} \) to display the menus.

4. Make sure Auto Answer is set to On.

Color 2.5-inch display models:
   Fax Settings > Receive Settings > Auto Answer > On

Monochrome 2-line display models:
   Fax Settings > Send/Receive Setup > Auto Answer > On

Note:
- When an answering machine is connected directly to this product, make sure you set Rings to Answer correctly using the following procedure.
- Depending on the region, Rings to Answer may be unavailable.

5. Press \( \text{Next} \) and \( \text{Down} \) to select Communication and press OK.

6. Select Rings to Answer and press OK.

7. Press \( \text{Up} \) or \( \text{Down} \) to select the number of rings and press OK.

Important:
Select more rings than needed for the answering machine to pick up. If it is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later. Otherwise the answering machine cannot receive voice calls.

Note:
When you receive a call and the other party is a fax, the product receives the fax automatically even if the answering machine picks up the call. If you pick up the phone, wait until the LCD screen displays a message saying that a connection has been made before you hang up. If the other party is a caller, the phone can be used as normal or a message can be left on the answering machine.
Receiving faxes manually

If your phone is connected to the product, you can receive fax data after the connection is made.

1. Load plain paper in the rear paper feed.  
   ➤ "Loading Paper and Envelopes" on page 22

2. When the telephone rings, lift the phone connected to the product.

3. When you hear a fax tone, select **Receive** on the control panel of the product.

4. Start receiving the fax.
   
   Color 2.5-inch display models:
   Press one of the ◇ buttons.

   Monochrome 2-line display models:
   Select **Yes**.

5. Put the phone back on the hook.

   **Note:**
   If Auto Answer mode is turned on, the received fax data is automatically printed, and you do not have to proceed to step 6.

6. Print the received fax.
   
   Color 2.5-inch display models:
   Press one of the ◇ buttons.

   Monochrome 2-line display models:
   Press **OK**.

Receive a fax by polling

This allows you to receive a fax from the fax information service you have called.

Follow the instructions below to receive a fax by polling.

1. Load plain paper in the rear paper feed.  
   ➤ "Loading Paper and Envelopes" on page 22

2. Press ◇ to enter the fax mode.
Enter the fax number.

Press \( \equiv \) to display the menus.

Select the menu shown below. Use \( \uparrow \) or \( \downarrow \) to select a menu, and press OK.

Color 2.5-inch display models:
Select Polling.

Monochrome 2-line display models:
Select Fax Mode > Polling. Press \( \equiv \) to return to the fax mode top screen.

Press one of the \( \Diamond \) buttons to receive the fax.

**Note:**
If Auto Answer mode is turned on, the received fax data is automatically printed, and you do not have to proceed to step 7.

Print the received fax.

Color 2.5-inch display models:
Press one of the \( \Diamond \) buttons.

Monochrome 2-line display models:
Press OK.

**Printing Reports**

Follow the instructions below to print a fax report.

1. Load plain paper in the rear paper feed.
   - “Loading Paper and Envelopes” on page 22
2. Press \( \Diamond \) to enter the fax mode.
3. Press \( \equiv \) to display the menus.
4. Select the menu shown below. Use \( \uparrow \) or \( \downarrow \) to select a menu, and press OK.

Color 2.5-inch display models:
Select Fax Report.

Monochrome 2-line display models:
Select Fax Settings > Print Report.
Faxing

5 Select the item you want to print.

Note:
Only Fax Log can be viewed on the screen.

6 Press one of the buttons to print the report you selected.

Fax Mode Menu List

Refer to the section below for the Fax mode menu list.

➡ “Fax Mode” on page 82
You can use this product as a printer, copier, scanner, and fax. When using one of these functions, except the printer function, select your desired function by pressing the corresponding Mode button on the control panel. Each mode’s main screen appears as you select the mode.

**Copy Mode**

*Note:*
*Depending on the model, some functions may not be available.*

**Color 2.5-inch display models**
Press the menu button to see the menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item and description.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper and Copy Settings</td>
<td>Layout: With Border, Borderless*</td>
</tr>
<tr>
<td></td>
<td>Reduce/Enlarge: Custom Size, Actual Size, Auto Fit Page, 10 × 15cm -&gt; A4, A4 -&gt; 10 × 15cm, 13 × 18 -&gt; 10 × 15, 10 × 15 -&gt; 13 × 18</td>
</tr>
<tr>
<td></td>
<td>Paper Size: A4, 10 × 15cm (4 × 6in), 13 × 18cm (5 × 7in), Legal</td>
</tr>
<tr>
<td></td>
<td>Paper Type: Plain Paper, Photo Paper</td>
</tr>
<tr>
<td></td>
<td>Quality: Draft, Standard Quality, Best</td>
</tr>
<tr>
<td>ID Card Copy</td>
<td>You can copy both sides of an ID card on one side of a sheet of A4 paper.</td>
</tr>
<tr>
<td>Ink Levels</td>
<td>- Checks the status of ink cartridges.</td>
</tr>
<tr>
<td>Maintenance</td>
<td>Nozzle Check: Prints a nozzle check pattern to check the condition of the print head.</td>
</tr>
<tr>
<td></td>
<td>Head Cleaning: Cleans the print head to improve the condition of the print head.</td>
</tr>
<tr>
<td></td>
<td>Head Alignment: Adjusts the alignment of the print head.</td>
</tr>
<tr>
<td></td>
<td>Ink Cartridge Replacement: Select to replace ink cartridges.</td>
</tr>
<tr>
<td>Printer Setup</td>
<td>Sound: On, Off</td>
</tr>
<tr>
<td></td>
<td>Sleep Timer: 3 minutes, 5 minutes, 10 minutes</td>
</tr>
<tr>
<td></td>
<td>Date/Time: Date Format, Time Format</td>
</tr>
<tr>
<td></td>
<td>Daylight Saving Time: Off, On</td>
</tr>
<tr>
<td></td>
<td>Country/Region: -</td>
</tr>
<tr>
<td></td>
<td>Language: -</td>
</tr>
</tbody>
</table>
### Menu List of Control Panel

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item and description.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wi-Fi/Network Settings</td>
<td>Wi-Fi Setup</td>
</tr>
<tr>
<td></td>
<td>See the online Network Guide. You can access the Wi-Fi Setup menus directly by pressing the (\text{WiFi} ) button.</td>
</tr>
<tr>
<td></td>
<td>Manual Wi-Fi/Network Setup</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi/Network Connection Check</td>
</tr>
<tr>
<td></td>
<td>You can check the network connection status, and print the report. If there is any problem with the connection, the report helps you find the solution.</td>
</tr>
<tr>
<td></td>
<td>Confirm Wi-Fi/Network Settings</td>
</tr>
<tr>
<td></td>
<td>You can see the current network settings and print a network status sheet.</td>
</tr>
<tr>
<td>Epson Connect Services</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>For instructions on how to use these menus, see the Epson Connect guide.</td>
</tr>
<tr>
<td></td>
<td>“Using Epson Connect Service” on page 9</td>
</tr>
<tr>
<td>Google Cloud Print Services</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>For details on the setting items, see the online Network Guide.</td>
</tr>
<tr>
<td>File Sharing Setup</td>
<td>-</td>
</tr>
<tr>
<td>Restore Default Settings</td>
<td>Fax Send/Receive Settings</td>
</tr>
<tr>
<td></td>
<td>Initializes Fax Send/Receive settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>Fax Data Settings</td>
</tr>
<tr>
<td></td>
<td>Initializes Fax Data settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>Wi-Fi/Network Setting</td>
</tr>
<tr>
<td></td>
<td>Initializes Wi-Fi/Network settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>All except Wi-Fi/Network &amp; Fax Settings</td>
</tr>
<tr>
<td></td>
<td>Initializes all settings except for Wi-Fi/Network &amp; Fax settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>All Settings</td>
</tr>
<tr>
<td></td>
<td>Initializes all settings to the factory default settings.</td>
</tr>
</tbody>
</table>

* Your image is slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the printout, or the area may be smeared when printing.

**Monochrome 2-line display models**

Press \(\equiv\) to see the menu.

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting item and description.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layout</td>
<td>With Border, Borderless*, ID Card Copy</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td>Actual Size, Auto Fit Page, Custom</td>
</tr>
<tr>
<td>Paper Size</td>
<td>A4, 10 × 15cm, 13 × 18cm, Legal</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Plain Paper, Photo Paper</td>
</tr>
<tr>
<td>Quality</td>
<td>Draft, Standard Quality, Best</td>
</tr>
<tr>
<td>Copy Density</td>
<td>-4 to +4</td>
</tr>
<tr>
<td>Setting Item</td>
<td>Setting item and description.</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Restore Default Settings</td>
<td>- Reset Fax Send/Receive Settings: Initializes Fax Send/Receive settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>- Reset Fax Data Settings: Initializes Fax Data settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>- Reset Network Settings: Initializes Network settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>- Reset Wi-Fi Settings: Initializes Wi-Fi settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>- Reset All except Network &amp; Fax Settings: Initializes all settings except for Network &amp; Fax settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>- Reset All except Wi-Fi &amp; Fax Settings: Initializes all settings except for Wi-Fi &amp; Fax settings to the factory default settings.</td>
</tr>
<tr>
<td></td>
<td>- Reset All Settings: Initializes all settings to the factory default settings.</td>
</tr>
<tr>
<td>Wi-Fi Settings (Wi-Fi capable models only)</td>
<td>- Wi-Fi Setup: See the online Network Guide. You can access the Wi-Fi Setup menus directly by pressing the Wi-Fi button.</td>
</tr>
<tr>
<td></td>
<td>- Check Wi-Fi Connection: You can check the network connection status, and print the report. If there is any problem with the connection, the report helps you find the solution.</td>
</tr>
<tr>
<td></td>
<td>- Confirm Wi-Fi Settings: You can see the current network settings.</td>
</tr>
<tr>
<td></td>
<td>- Print Wi-Fi Status Sheet: You can print a network status sheet.</td>
</tr>
<tr>
<td>Network Settings (Ethernet capable models only)</td>
<td>- Check Network Connection: You can check the network connection status, and print the report. If there is any problem with the connection, the report helps you find the solution.</td>
</tr>
<tr>
<td></td>
<td>- Confirm Network Settings: You can see the current network settings.</td>
</tr>
<tr>
<td></td>
<td>- Print Network Status Sheet: You can print a network status sheet.</td>
</tr>
</tbody>
</table>
### Setting Item

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting item and description.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>Ink Levels</td>
<td>Checks the status of ink cartridges.</td>
</tr>
<tr>
<td>Nozzle Check</td>
<td>Prints a nozzle check pattern to check the condition of the print head.</td>
</tr>
<tr>
<td>Head Cleaning</td>
<td>Cleans the print head to improve the condition of the print head.</td>
</tr>
<tr>
<td>Head Alignment</td>
<td>Adjusts the alignment of the print head.</td>
</tr>
<tr>
<td>Ink Cartridge Replacement</td>
<td>Select to replace ink cartridges.</td>
</tr>
<tr>
<td>Sound</td>
<td>On, Off</td>
</tr>
<tr>
<td>LCD Contrast</td>
<td>+1 to +16</td>
</tr>
<tr>
<td>Scroll Speed</td>
<td>Fast, Standard, Slow</td>
</tr>
<tr>
<td>Sleep Timer</td>
<td>3minutes, 5minutes, 10minutes</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date, Time</td>
</tr>
<tr>
<td>Daylight Saving Time</td>
<td>On, Off</td>
</tr>
<tr>
<td>Country/Region</td>
<td>-</td>
</tr>
<tr>
<td>Language</td>
<td>-</td>
</tr>
</tbody>
</table>

*Your image is slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the printout, or the area may be smeared when printing.*

### Fax Mode

**Note:**
*Depending on the model, some functions may not be available.*

**Color 2.5-inch display models**

Press ≠ to see the menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Settings</td>
<td>Quality</td>
<td>Select this option to change the quality for fax data you are sending.</td>
</tr>
<tr>
<td></td>
<td>Contrast</td>
<td>Select this option to change the contrast for fax data you are sending.</td>
</tr>
<tr>
<td>Speed Dial Setup</td>
<td>Create</td>
<td>➤ “Setting up speed dial entries” on page 68.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Group Dial Setup</td>
<td>Create</td>
<td>➤ “Setting up group dial entries” on page 69.</td>
</tr>
<tr>
<td></td>
<td>Edit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td></td>
</tr>
</tbody>
</table>
## Menu List of Control Panel

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Fax Later</td>
<td>-</td>
<td>➤ “Sending a fax at a specified time” on page 73.</td>
</tr>
<tr>
<td>Broadcast Fax</td>
<td>-</td>
<td>➤ “Sending faxes by broadcasting” on page 72.</td>
</tr>
<tr>
<td>Polling</td>
<td>-</td>
<td>➤ “Receive a fax by polling” on page 76.</td>
</tr>
<tr>
<td>Fax Report</td>
<td>Fax Log</td>
<td>Prints or displays the communication log.</td>
</tr>
<tr>
<td></td>
<td>Last Transmission</td>
<td>Prints a communication-in log for the previous transmission or the previous polling results received.</td>
</tr>
<tr>
<td></td>
<td>Speed Dial List</td>
<td>Prints the speed dial list.</td>
</tr>
<tr>
<td></td>
<td>Group Dial List</td>
<td>Prints the group dial list.</td>
</tr>
<tr>
<td></td>
<td>Reprint Faxes</td>
<td>Reprints from the latest fax received. When the memory is full, the oldest faxes are erased first.</td>
</tr>
<tr>
<td></td>
<td>Protocol Trace</td>
<td>Prints the protocol for the latest communication.</td>
</tr>
</tbody>
</table>
## Menu List of Control Panel

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fax Settings</td>
<td>Send Settings</td>
<td><strong>Quality</strong>: Select this option to change the quality for fax data you are sending. <strong>Contrast</strong>: Select this option to change the contrast for fax data you are sending. <strong>Last Transmission Report</strong>: Indicates whether or when the product prints a report for outgoing faxes. Select <strong>Off</strong> to turn off report printing, select <strong>On Error</strong> to print reports only when an error occurs, or select <strong>On Send</strong> to print reports for every fax you send.</td>
</tr>
<tr>
<td>Receive Settings</td>
<td></td>
<td><strong>Auto Answer</strong>: <em>“Setting up to receive faxes automatically” on page 75.</em> <strong>Paper Size</strong>: Indicates the size of paper used for printing received faxes and fax reports. <strong>Auto Reduction</strong>: Indicates whether large received faxes are reduced in size to fit on A4-size, or printed at their original size on multiple sheets.</td>
</tr>
<tr>
<td>Communication</td>
<td></td>
<td><strong>DRD</strong>: Indicates the type of answer ring pattern you want to use to receive faxes. To select an option other than <strong>All</strong> (or <strong>Off</strong>), you must set up your phone system to use different ring patterns. This option may be <strong>On</strong> or <strong>Off</strong> depending on the region. <strong>ECM</strong>: Indicates whether or not to use Error Correction Mode to automatically correct fax data sent/received with errors due to the line or any other problems. Color faxes cannot be sent/received when ECM is off. <strong>Fax Speed</strong>: Indicates the speed at which you transmit and receive faxes. <strong>Rings to Answer</strong>: Indicates the number of rings that must occur before the product automatically receives a fax. Depending on the region, this setting may not be displayed. <strong>Dial Tone Detection</strong>: When this is set to <strong>On</strong>, the product starts dialing after it detects a dial tone. It may not be able to detect a dial tone when a PBX (Private Branch Exchange) or a TA (Terminal Adapter) is connected. In that case, set to <strong>Off</strong>. However, doing so may drop the first digit of a fax number and send the fax to the wrong number. <strong>Dial Mode</strong>: Indicates the type of phone system to which you have connected the product. Depending on the region, this setting may not be displayed. <strong>Header</strong>: <em>“Creating header information” on page 70.</em></td>
</tr>
<tr>
<td>Check Fax Connection</td>
<td></td>
<td>Checks the status of your fax connection.</td>
</tr>
</tbody>
</table>
## Menu List of Control Panel

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Levels</td>
<td></td>
<td>🔄 “Copy Mode” on page 79.</td>
</tr>
<tr>
<td>Maintenance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Printer Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wi-Fi/Network Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Connect Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Google Cloud Print Services</td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Sharing Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restore Default Settings</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Monochrome 2-line display models
Press ⇔ to see the menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality</td>
<td>-</td>
<td>Select this option to change the quality for fax data you are sending.</td>
</tr>
<tr>
<td>Contrast</td>
<td>-</td>
<td>Select this option to change the contrast for fax data you are sending.</td>
</tr>
<tr>
<td>Send Fax Later</td>
<td>-</td>
<td>🔄 “Sending a fax at a specified time” on page 73.</td>
</tr>
<tr>
<td>Fax Mode</td>
<td>Sending</td>
<td>Default mode to send faxes normally.</td>
</tr>
<tr>
<td></td>
<td>Polling</td>
<td>🔄 “Receive a fax by polling” on page 76.</td>
</tr>
<tr>
<td>Menu</td>
<td>Setting item</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Fax Settings</strong></td>
<td>Print Report</td>
<td><strong>Fax Log</strong>: Prints or displays the communication log.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Last Transmission</strong>: Prints a communication-in log for the previous transmission or the previous polling results received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Speed Dial List</strong>: Prints the speed dial list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Group Dial List</strong>: Prints the group dial list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Reprint Faxes</strong>: Reprints from the latest fax received. When the memory is full, the oldest faxes are erased first.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Protocol Trace</strong>: Prints the protocol for the latest communication.</td>
</tr>
<tr>
<td>Speed Dial Setup</td>
<td></td>
<td>➤ “Setting Up Fax Features” on page 68.</td>
</tr>
<tr>
<td>Group Dial Setup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send/Receive Setup</td>
<td>Auto Answer: ➤ “Setting up to receive faxes automatically” on page 75.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quality:</td>
<td>Select this option to change the quality for fax data you are sending.</td>
</tr>
<tr>
<td></td>
<td>Contrast:</td>
<td>Select this option to change the contrast for fax data you are sending.</td>
</tr>
<tr>
<td></td>
<td>Paper Size:</td>
<td>Indicates the size of paper used for printing received faxes and fax reports.</td>
</tr>
<tr>
<td></td>
<td>Auto Reduction:</td>
<td>Indicates whether large received faxes are reduced in size to fit on A4-size, or printed at their original size on multiple sheets.</td>
</tr>
<tr>
<td></td>
<td>Last Transmission Report: Indicates whether or when the product prints a report for outgoing faxes. Select Off to turn off report printing, select On Error to print reports only when an error occurs, or select On Send to print reports for every fax you send.</td>
<td></td>
</tr>
<tr>
<td>Communication</td>
<td>DRD:</td>
<td>Indicates the type of answer ring pattern you want to use to receive faxes. To select an option other than All (or Off), you must set up your phone system to use different ring patterns. This option may be On or Off depending on the region.</td>
</tr>
<tr>
<td></td>
<td>ECM:</td>
<td>Indicates whether or not to use Error Correction Mode to automatically correct fax data sent/received with errors due to the line or any other problems. Color faxes cannot be sent/received when ECM is off.</td>
</tr>
<tr>
<td></td>
<td>Fax Speed:</td>
<td>Indicates the speed at which you transmit and receive faxes.</td>
</tr>
<tr>
<td></td>
<td>Rings to Answer:</td>
<td>Indicates the number of rings that must occur before the product automatically receives a fax. Depending on the region, this setting may not be displayed.</td>
</tr>
<tr>
<td></td>
<td>Dial Tone Detection:</td>
<td>When this is set to On, the product starts dialing after it detects a dial tone. It may not be able to detect a dial tone when a PBX (Private Branch Exchange) or a TA (Terminal Adapter) is connected. In that case, set to Off. However, doing so may drop the first digit of a fax number and send the fax to the wrong number.</td>
</tr>
<tr>
<td></td>
<td>Dial Mode:</td>
<td>Indicates the type of phone system to which you have connected the product. Depending on the region, this setting may not be displayed.</td>
</tr>
<tr>
<td>Check Fax Connection</td>
<td></td>
<td>Checks the status of your fax connection.</td>
</tr>
<tr>
<td>Header</td>
<td></td>
<td>➤ “Creating header information” on page 70.</td>
</tr>
</tbody>
</table>
Menu List of Control Panel

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Default Settings</td>
<td>-</td>
<td>“Copy Mode” on page 79.</td>
</tr>
<tr>
<td>Wi-Fi Settings</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Network Settings</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

Scan Mode

**Note:**
Depending on the model, some functions may not be available.

Color 2.5-inch display models

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting and Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan to USB Device</td>
<td>Format: JPEG, PDF</td>
</tr>
<tr>
<td></td>
<td>Scan Area: A4, Auto Cropping, Max Area, Legal</td>
</tr>
<tr>
<td></td>
<td>Document: Text, Photograph</td>
</tr>
<tr>
<td></td>
<td>Resolution: 200dpi, 300dpi, 600dpi</td>
</tr>
<tr>
<td></td>
<td>Contrast: -4 to +4</td>
</tr>
<tr>
<td></td>
<td>Document Orientation: Portrait, Landscape</td>
</tr>
<tr>
<td>Scan to Cloud</td>
<td>For instructions on use, see the Epson Connect guide. “Using Epson Connect Service” on page 9</td>
</tr>
<tr>
<td>Scan to PC</td>
<td>“Basic Scanning from the Control Panel” on page 47</td>
</tr>
<tr>
<td>Scan to PC (PDF)</td>
<td></td>
</tr>
<tr>
<td>Scan to PC (Email)</td>
<td></td>
</tr>
<tr>
<td>Scan to PC (WSD)</td>
<td>This feature is only available for English versions of Windows 7/Vista.</td>
</tr>
</tbody>
</table>

Press \( \equiv \) to see the menu.
## Menu List of Control Panel

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Levels</td>
<td>➪ “Copy Mode” on page 79.</td>
</tr>
<tr>
<td>Maintenance</td>
<td></td>
</tr>
<tr>
<td>Printer Setup</td>
<td></td>
</tr>
<tr>
<td>Wi-Fi/Network Settings</td>
<td></td>
</tr>
<tr>
<td>Epson Connect Services</td>
<td></td>
</tr>
<tr>
<td>Google Cloud Print Services</td>
<td></td>
</tr>
<tr>
<td>File Sharing Setup</td>
<td></td>
</tr>
<tr>
<td>Restore Default Settings</td>
<td></td>
</tr>
</tbody>
</table>

### Monochrome 2-line display models

<table>
<thead>
<tr>
<th>Menu</th>
<th>Setting and Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan to PC</td>
<td>➪ “Basic Scanning from the Control Panel” on page 47</td>
</tr>
<tr>
<td>Scan to PC (PDF)</td>
<td></td>
</tr>
<tr>
<td>Scan to PC (Email)</td>
<td></td>
</tr>
<tr>
<td>Scan to PC (WSD)</td>
<td>This feature is only available for English versions of Windows 7/Vista.</td>
</tr>
</tbody>
</table>

Press ➪ to see the menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore Default Settings</td>
<td>➪ “Copy Mode” on page 79.</td>
</tr>
<tr>
<td>Wi-Fi Settings</td>
<td></td>
</tr>
<tr>
<td>Network Settings</td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td></td>
</tr>
</tbody>
</table>
Replacing Ink Cartridges

Ink Cartridge Safety Instructions, Precautions, and Specifications

Safety instructions

Observe the following when handling the ink cartridges:

- Keep ink cartridges out of the reach of children.

- Be careful when you handle used ink cartridges, as there may be some ink around the ink supply port. 
  If ink gets on your skin, wash the area thoroughly with soap and water. 
  If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a thorough flushing, see a doctor immediately. 
  If ink gets into your mouth, spit it out immediately and see a doctor right away.

- Do not remove or tear the label on the cartridge; this can cause leakage.

- Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become unusable.

- Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.
Do not touch the green IC chip or the small window on the side of the cartridge. Doing so may prevent normal operation and printing.

Do not leave the product with the ink cartridges removed or do not turn off the product during cartridge replacement. Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

### Precautions on ink cartridge replacement

Read all of the instructions in this section before replacing the ink cartridges.

- **Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and under certain circumstances, may cause erratic product behavior. Information about non-genuine ink levels may not be displayed.**

- **Gently shake all ink cartridges four or five times before opening the package.**

- **Do not shake ink cartridges too vigorously; otherwise ink may leak from the cartridge.**

- **This product uses ink cartridges equipped with an IC chip that monitors information such as the amount of remaining ink for each cartridge. This means that even if the cartridge is removed from the product before it is expended, you can still use the cartridge after reinserting it back into the product. However, when reinserting a cartridge, some ink may be consumed to guarantee product performance.**

- **You cannot use the cartridge that came with your product for the replacement.**

- **To maintain optimum print head performance, some ink is consumed from all cartridges not only during printing but also during maintenance operations such as ink cartridge replacement and print head cleaning.**

- **If you need to remove an ink cartridge temporarily, be sure to protect the ink supply area from dirt and dust. Store the ink cartridge in the same environment as the product. When storing the cartridge, be sure that its label identifying the color of the ink cartridge is facing upward. Do not store ink cartridges upside down.**

- **The ink supply port is equipped with a valve designed to contain the release of excess ink; there is no need to supply your own covers or plugs. However, careful handling is recommended. Do not touch the supply port of the ink cartridge or its surrounding area.**

- **For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink cartridges with low ink status may not be used when reinserted.**

- **Do not open the ink cartridge package until you are ready to install it in the product. The cartridge is vacuum packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal printing may not be possible.**
Install all ink cartridges; otherwise, you cannot print.

When color ink is expended and black ink still remains, you can continue printing temporarily with black ink only. For more information refer to “Temporarily Printing with Black Ink When Color Ink Cartridges are Expended” on page 94.

If an ink cartridge is running low, prepare a new ink cartridge.

Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.

You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or you may not be able to print.

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

Store ink cartridges in a cool, dark place.

Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

Ink Cartridge Specifications

Epson recommends using the ink cartridge before the date printed on the package.

The ink cartridges packaged with your product are partly used during initial setup. In order to produce high quality printouts, the print head in your product will be fully charged with ink. This one-off process consumes a quantity of ink and therefore these cartridges may print fewer pages compared to subsequent ink cartridges.

Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the frequency of your prints and environmental conditions such as temperature.

To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve remains in the cartridge when your product indicates to replace the cartridge. The yields quoted for you do not include this reserve.

Although the ink cartridges may contain recycled materials, this does not affect product function or performance.

When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the paper type or print quality settings. This is because a mixture of color inks is used to create black.

Checking the Ink Cartridge Status

For Windows

Note:
When an ink cartridge is running low, the Low Ink Reminder screen automatically appears. You can also check the ink cartridge status from this screen. If you do not want to display this screen, first access the printer driver and then click the Maintenance tab, and then Monitoring Preferences. On the Monitoring Preferences screen, clear the See Low Ink Reminder alerts check box.
To check the ink cartridge status, do one of the following:

- Open the printer driver, click the **Main** tab, and then click the **Ink Levels** button.

- Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the following section:
  → “From the shortcut icon on the taskbar” on page 30

- Open the printer driver, click the **Maintenance** tab, then click the **EPSON Status Monitor 3** button. A graphic displays the ink cartridge status.

**Note:**

- If **EPSON Status Monitor 3** does not appear, access the printer driver and click the **Maintenance** tab and then the **Extended Settings** button. In the Extended Settings window, check the **Enable EPSON Status Monitor 3** check box.

- Depending on current settings, the simplified status monitor may be displayed. Click the **Details** button to display the window above.

- The ink levels displayed are an approximate indication.

---

**For Mac OS X**

You can check the ink cartridge status using **EPSON Status Monitor**. Follow the steps below.


   ➔ “Accessing the printer driver for Mac OS X” on page 30
Replacing Ink Cartridges

2 Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

![EPSON Status Monitor](image)

**Note:**
- The graphic displays the ink cartridge status when EPSON Status Monitor was first opened. To update the ink cartridge status, click **Update**.
- The ink levels displayed are an approximate indication.

Using the control panel

1 Press 
 to display the menus.

2 For Color 2.5-inch display models:
   Select **Ink Levels**.
   
   For Monochrome 2-line display models:
   Select **Maintenance > Ink Levels**.

**Note:**
The ink levels displayed are an approximate indication.
Temporarily Printing with Black Ink When Color Ink Cartridges are Expended

When color ink is expended and black ink still remains, you can continue printing for a short time using only black ink. However, you should replace the expended ink cartridge(s) as soon as possible. See the following section to continue printing temporarily with black ink.

Note:
The actual amount of time will vary depending on the usage conditions, images printed, print settings, and frequency of use.

For Windows

Note:
This function is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

Follow the steps below to continue printing temporarily with black ink.
Replacing Ink Cartridges

1. When EPSON Status Monitor 3 tells you to cancel your print job, click **Cancel** or **Cancel Print** to cancel your print job.

![EPSON Status Monitor 3](image)

**Note:**
If the error stating that a color ink cartridge is expended originates with another computer on the network, you may need to cancel the print job at the product.

2. Load plain paper or envelope.

3. Access the printer settings.
   ➜ **"Accessing the printer driver for Windows" on page 29**

4. Click the Main tab, and make suitable settings.

5. Select **plain papers** or **Envelope** as the Paper Type setting.

6. Select the **Grayscale** as the Color setting.

7. Click **OK** to close the printer settings window.
Print your file.

EPSON Status Monitor 3 is displayed on your computer screen again. Click **Print in Black** to print with black ink.

### For Mac OS X

Follow the steps below to continue printing temporarily with black ink.

1. If printing can not be resumed, click the product icon in the Dock. If an error message is displayed prompting you to cancel the print job, click **Delete** and follow the steps below to reprint the document with black ink.

   ![EPSON Status Monitor 3](image)

   **Note:**
   If the error stating that a color ink cartridge is expended originates with another computer on the network, you may need to cancel the print job at the product.

2. Open **System Preferences**, click **Print & Scan** (Mac OS X 10.7) or **Print & Fax** (Mac OS X 10.6 or 10.5), and select the product from the Printers list. Next, click **Options & Supplies** and then **Driver**.

3. Select **On** for Permit temporary black printing.

4. Load plain paper or envelope.

5. Access the Print dialog box.
   ⇒ “Accessing the printer driver for Mac OS X” on page 30

6. Click the **Show Details** button (for Mac OS X 10.7) or the ▼ button (for Mac OS X 10.6 or 10.5) to extend this dialog box.
Select the product you are using as the Printer setting, and then make suitable settings.

Select Print Settings from the pop-up menu.

Select plain papers or Envelope as the Media Type setting.

Select the Grayscale check box.

Click Print to close the Print dialog box.

Conserving Black Ink When the Cartridge Is Low (For Windows Only)

Note: This function is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

The window below appears when black ink runs low and there is more color ink than black ink. It appears only when plain papers is selected as the paper type, and Standard is selected as the Quality.

The window gives you the option to either continue using black ink normally or conserve black ink by using a mixture of color inks to create black.

- Click the Yes button to use a mixture of color inks to create black. You will see the same window the next time you print a similar job.

- Click the No button to continue using the remaining black ink for the job you are printing. You will see the same window the next time you print a similar job, and again have the option to conserve black ink.

- Click Disable this feature to continue using the remaining black ink.
Replacing an Ink Cartridge

Using the control panel

1 When prompted to replace an ink cartridge, open the scanner unit and press OK. The ink cartridge holder moves to the ink cartridge replacement position. When you replace an ink cartridge before it is expended, follow the instruction below.
Press ⊞ and select Maintenance > Ink Cartridge Replacement.

Important:

- Do not lift up the scanner unit when the document cover is open.
- Do not move the ink cartridge holder by hand; otherwise, you may damage the product.
Replacing Ink Cartridges

2 Pinch and remove the ink cartridge.

Note:
Removed ink cartridges may have ink around the ink supply port, so be careful not to get any ink on the surrounding area when removing the cartridges.

3 Gently shake new replacement cartridges four or five times and then unpack.

Important:
- Be careful not to break the hooks on the side of the ink cartridge when you remove it from the package.
- Do not touch the green IC chip or the small window on the side of the cartridge. Doing so may prevent normal operation and printing.
Remove only the yellow tape.

Important:
- You must remove the yellow tape from the cartridge before installing it; otherwise, print quality may decline or you may not be able to print.
- If you have installed an ink cartridge without removing the yellow tape, take the cartridge out of the product, remove the yellow tape, and then reinstall it.
- Do not remove the transparent seal from the bottom of the cartridge; otherwise, the cartridge may become unusable.
- Do not remove or tear the label on the cartridge; otherwise, ink will leak.

Insert the cartridge and press it until it clicks. Make sure the top surface of the ink cartridges align.

Close the scanner unit slowly and press OK. Ink charging starts.

Note:
- The light continues to flash while the product is charging ink. Do not turn off the product during ink charging. If the ink charging is incomplete, you may not be able to print.
- If you had to replace an ink cartridge during copying, to ensure copy quality after ink charging is finished, cancel the job that is copying and start again from placing the originals.

Ink cartridge replacement is complete. The product will return to its previous status.
For Windows

When you need to replace an expended ink cartridge, click **How to** in the status monitor window. Follow the on-screen instructions to replace the cartridge.
For more information on using your computer to replace ink cartridges, see the section below.

⇒ “For Windows” on page 121.

If you need to replace an ink cartridge before it is low or expended, click the button on the **Maintenance** tab in your printer driver.

⇒ “Accessing the printer driver for Windows” on page 29

For Mac OS X

When you need to replace an expended ink cartridge, click **How to** in the status monitor window. Follow the on-screen instructions to replace the cartridge.
For more information on using your computer to replace ink cartridges, see the section below.

⇒ “For Mac OS X” on page 122.
If you need to replace an ink cartridge before it is low or expended, access the Epson Printer Utility 4. *“Accessing the printer driver for Mac OS X” on page 30.*

For more information on using the printer utilities, see the online help.
Maintaining Your Product and Software

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or from the product by using the buttons.

Using the Nozzle Check utility for Windows

Follow the steps below to use the Nozzle Check utility.

1. Make sure that no warnings or errors are indicated in the control panel.
2. Make sure that A4-size paper is loaded in the rear paper feed.
3. Right-click the product icon on the taskbar, then select Nozzle Check.
   - If the product icon does not appear, refer to the following section to add the icon.
     ➔ “From the shortcut icon on the taskbar” on page 30
4. Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

1. Make sure that no warnings or errors are indicated in the control panel.
2. Make sure that A4-size paper is loaded in the rear paper feed.
   ➔ “Accessing the printer driver for Mac OS X” on page 30
4. Click the Nozzle Check icon.
5. Follow the on-screen instructions.
Using the control panel

Follow the steps below to check the print head nozzles using the product control panel.

1. Make sure that no warnings or errors are indicated in the control panel.

2. Make sure that A4-size paper is loaded in the rear paper feed.

3. Press \( x \) to display the menus.

4. Select Maintenance.

5. Select Nozzle Check and follow the instructions in the LCD screen to print a nozzle check pattern.

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality problems, such as gaps or missing segments in the test lines, the print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a misaligned print head.

"Cleaning the Print Head" on page 105
"Aligning the Print Head" on page 106
Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve these problems by cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer driver or from the product by using the buttons.

**Important:**
Do not turn off the product during head cleaning. If the head cleaning is incomplete, you may not be able to print.

**Note:**
- Do not open the scanner unit during head cleaning.
- Because print head cleaning uses some ink from all cartridges, clean the print head only if quality declines; for example, if the printout is blurry or the color is incorrect or missing.
- Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.
- When ink is low you may not be able to clean the print head. When ink is expended you cannot clean the print head. Replace the appropriate ink cartridge first.
- If print quality has not improved after repeating this procedure about four times, leave the product on and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary. If print quality has still not improved, contact Epson support.
- To maintain print quality, we recommend printing a few pages on a regular basis.

### Using the Head Cleaning utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that no warnings or errors are indicated in the control panel.

2. Right-click the product icon on the taskbar, then select **Head Cleaning**.
   
   If the product icon does not appear, refer to the following section to add the icon.
   
   ➤ "From the shortcut icon on the taskbar" on page 30

3. Follow the on-screen instructions.

### Using the Head Cleaning utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure that no warnings or errors are indicated in the control panel.

   
   ➤ "Accessing the printer driver for Mac OS X" on page 30
Click the **Head Cleaning** icon.

Follow the on-screen instructions.

### Using the control panel

Follow the steps below to clean the print head using the product control panel.

1. Make sure that no warnings or errors are indicated in the control panel.
2. Press \( \equiv \) to display the menus.
3. Select **Maintenance**.
4. Select **Head Cleaning**.
5. Follow the instructions on the LCD screen to continue.

### Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem by using the Print Head Alignment utility in your printer driver or by using the product buttons.

Refer to the appropriate section below.

**Note:**

Do not press \( \equiv \) to cancel printing while printing a test pattern with the Print Head Alignment utility.

### Using the Print Head Alignment utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no warnings or errors are indicated in the control panel.
2. Make sure A4-size paper is loaded in the rear paper feed.
3. Right-click the product icon on the taskbar, then select **Print Head Alignment**.

If the product icon does not appear, refer to the following section to add the icon.

⇒ “From the shortcut icon on the taskbar” on page 30
Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no warnings or errors are indicated in the control panel.

2. Make sure A4-size paper is loaded in the rear paper feed.

   ➔ “Accessing the printer driver for Mac OS X” on page 30

4. Click the Print Head Alignment icon.

5. Follow the on-screen instructions to align the print head.

Using the control panel

Follow the steps below to align the print head using the product control panel.

1. Make sure that no warnings or errors are indicated in the control panel.

2. Make sure that A4-size paper is loaded in the rear paper feed.

3. Press ‡ to display the menus.

4. Select Maintenance.

5. Select Head Alignment and follow the instructions in the LCD screen to print the patterns.

6. Find the most solid pattern in each of #1 to #4 groups.

7. Enter the pattern number for the most solid pattern in #1 group.
Repeat step 7 for the other groups (#2 to #4).

Finish aligning the print head.

Setting/Changing Time and Region

Follow the steps below to set the time and region using the product control panel.

1. Press \( \equiv \) to display the menus.

2. Color 2.5-inch display models:
   Select Printer Setup.
   Monochrome 2-line display models:
   Select Maintenance.

3. Select Date/Time.

4. Select the date format.

5. Set the date.

6. Select the time format.

7. Set the time.

   **Note:**
   To select daylight saving time, set Daylight Saving Time to On.

8. Select Country/Region.

9. Select the region.

10. Select Yes.

   **Note:**
   When the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn the power back on.
Saving Power

The LCD screen turns black if no operations are performed for a set period.

You can adjust the time before power management is applied. Any increase will affect the product’s energy efficiency. Please consider the environment before making any change.

Follow the steps below to adjust the time.

For Windows

1. Access the printer settings.
   ⇒ “Accessing the printer driver for Windows” on page 29

2. Click the Maintenance tab, and then click the Printer and Option Information button.

3. Select 3 minutes, 5 minutes, or 10 minutes as the Sleep Timer setting.

4. Click the OK button.

For Mac OS X

   ⇒ “Accessing the printer driver for Mac OS X” on page 30

2. Click the Printer Settings button. The Printer Settings screen appears.

3. Select 3 minutes, 5 minutes, or 10 minutes as the Sleep Timer setting.

4. Click the Apply button.

Using the control panel

1. Press : to display the menus.

2. Color 2.5-inch display models:
   Select Printer Setup.

   Monochrome 2-line display models:
   Select Maintenance.

3. Select Sleep Timer.
Select 3 minutes, 5 minutes, or 10 minutes.

Cleaning the Product

Cleaning the exterior of the product

To keep your product operating at its best, clean it thoroughly several times a year by using the following instructions.

**Important:**

Never use alcohol or thinner to clean the product. These chemicals can damage the product.

- Use a soft, dry, clean cloth to clean the LCD screen. Do not use liquid or chemical cleaners.
- Use a soft, dry, clean cloth to clean the surface of the scanner glass.
  
  If straight lines appear in the printout or the scanned data, clean the left side of the scanner glass carefully.

- If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of glass cleaner and a soft cloth to remove it. Wipe off all remaining liquid.

- Open the ADF cover and use a soft, dry, clean cloth to clean the roller and the interior of the ADF (only for products with ADF function).

- Do not press the surface of the scanner glass with any force.
Be careful not to scratch or damage the surface of the scanner glass, and do not use a hard or abrasive brush to clean it. A damaged glass surface can decrease the scan quality.

Cleaning the interior of the product

To keep your print results at their best, clean the roller inside by using the following procedure.

⚠️ Caution:
Be careful not to touch the parts inside the product.

⚠️ Important:
- Be careful to keep water away from the electronic components.
- Do not spray the inside of the product with lubricants.
- Unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is needed.

1. Make sure that no warnings or errors are indicated in the control panel.
2. Load several sheets of A4-size plain paper in the rear paper feed.
3. Press ◀ to enter the copy mode.
4. Press one of the ◆ buttons to make a copy without placing a document on the scanner glass.
5. Repeat step 4 until the paper is not smeared with ink.

Transporting the Product

If you move the product some distance, you need to prepare it for transportation in its original box or one of a similar size.

⚠️ Important:
- When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down; otherwise ink may leak.
- Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the product from printing.

1. Remove all paper from the rear paper feed and make sure the product is off.
Open the scanner unit and make sure the ink cartridge holder is in the home position on the right.

**Note:**
If the ink cartridge holder is not in the home position on the right, turn on the product and wait until the ink cartridge holder locks in the far right position. Then turn off the product.

Secure the ink cartridge holder to the case with tape as shown, then close the scanner unit.

**Note:**
Do not place tape on the white flat cable inside the product.

Unplug the power cord from the outlet, then disconnect all cables from the product.

Close the paper support and the output tray.

Repack the product in the box, using the protective materials that came with it.

**Note:**
- Keep the product level during transport.
- Be sure to remove the protective materials from the product before using it again.
Checking and Installing Your Software

Checking the software installed on your computer

To use the functions described in this User’s Guide, you need to install the following software.

- Epson Driver and Utilities
- Epson Easy Photo Print
- Epson Event Manager

Follow the steps below to check that the software is installed on your computer.

For Windows

1. **Windows 7 and Vista:** Click the start button and select Control Panel.
   
   **Windows XP:** Click Start and select Control Panel.

2. **Windows 7 and Vista:** Click Uninstall a program from the Programs category.
   
   **Windows XP:** Double-click the Add or Remove Programs icon.

3. Check the list of currently installed programs.

For Mac OS X

1. Double-click Macintosh HD.

2. Double-click the Epson Software folder in the Applications folder and check the contents.

**Note:**

- The Applications folder contains software provided by third parties.
- To check that the printer driver is installed, click System Preferences on the Apple menu and then click Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5). Then locate your product in the Printers list box.

Installing the software

Insert the product software disk that came with your product and select the software you want to install on the Software Select screen.
Uninstalling Your Software

You may need to uninstall and then reinstall your software to solve certain problems or if you upgrade your operating system.

See the following section for information on determining what applications are installed.

“Checking the software installed on your computer” on page 113

For Windows

Note:

- For Windows 7 and Vista, you need an administrator account and password if you log on as a standard user.
- For Windows XP, you must log on to a Computer Administrator account.

1. Turn off the product.

2. Disconnect the product’s interface cable from your computer.

3. Do one of the following.

   Windows 7 and Vista: Click the start button and select Control Panel.

   Windows XP: Click Start and select Control Panel.

4. Do one of the following.

   Windows 7 and Vista: Click Uninstall a program from the Programs category.

   Windows XP: Double-click the Add or Remove Programs icon.

5. Select the software you want to uninstall such as your product’s driver and the application from the list displayed.

6. Do one of the following.

   Windows 7: Click Uninstall/Change or Uninstall.

   Windows Vista: Click Uninstall/Change or Uninstall, and then click Continue in the User Account Control window.

   Windows XP: Click Change/Remove or Remove.

Note:
If you chose to uninstall your product’s printer driver in step 5, select the icon for your product and then click OK.
When the confirmation window appears, click Yes or Next.

Follow the on-screen instructions.

In some cases, a message may appear to prompt you to restart your computer. If so, make sure I want to restart my computer now is selected and click Finish.

**For Mac OS X**

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To uninstall your software you need to download the Uninstaller. Access the site at: <a href="http://www.epson.com">http://www.epson.com</a>. Next, select the support section of your local Epson Web site.</td>
</tr>
<tr>
<td>To uninstall applications, you must log on to a Computer Administrator account. You cannot uninstall programs if you log on as a limited account user.</td>
</tr>
<tr>
<td>Depending on the application, the Installer may be separated from the Uninstaller.</td>
</tr>
</tbody>
</table>

1. Quit all running applications.
2. Double-click the **Uninstaller** icon in your Mac OS X hard drive.
3. Select the check boxes for the software you want to uninstall, such as the printer driver and the application, from the list displayed.
4. Click **Uninstall**.
5. Follow the on-screen instructions.

If you cannot find the software you want to uninstall in the Uninstaller window, double-click the **Applications** folder in your Mac OS X hard drive, select the application you want to uninstall, and then drag it to the Trash icon.

**Note:**

If you uninstall the printer driver and the name of your product remains in the Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5) window, select the name of your product and click the - *remove* button.
Transferring Data Using an External Storage Device

Note:
The availability of this feature varies by product.

You can use the product’s external USB port to copy files to a computer connected to the product. You can also use it to copy files on your computer to the storage device.

Precautions on Storage Devices

Keep the following in mind when copying files between your storage device and computer:

- Check the documentation that came with your storage device and any adapter you may be using for any handling guidelines.
- Do not copy files to a storage device while you are printing from your storage device.
- The product display does not update information about your storage device after you copy files to it or delete files from it. To update the information displayed, eject and reload the storage device.

Copying Files Between a Storage Device and Your Computer

Copying files to your computer

1. Make sure the product is turned on and a storage device is connected.

2. **Windows 7 and Vista:**
   Click the start button and select Computer.
   
   **Windows XP:**
   Click Start and select My Computer.
   
   **Mac OS X:**
   The removable disk icon (إدارة) appears on your desktop automatically.

3. Double-click the removable disk icon, then select the folder in which your files are saved.

Note:
If you have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk” is displayed as the drive name on Windows XP.
Transferring Data Using an External Storage Device

Select the files you want to copy and drag them to a folder on your computer’s hard drive.

**Important:**
For Mac OS X users
When you remove the storage device, always drag the removable disk icon on your desktop into the trash before you remove the storage device or you may lose data on the device.

Saving files to a storage device

1. Make sure the product is turned on and a storage device is connected.

2. **Windows 7 and Vista:**
   Click the start button and select **Computer**.

   **Windows XP:**
   Click **Start** and select **My Computer**.

   **Mac OS X:**
   The removable disk icon (disk icon) appears on your desktop automatically.

3. Double-click the removable disk icon, then select the folder in which you want to save your files.

   **Note:**
   If you have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk” is displayed as the drive name on Windows XP.

4. Select the folder on your computer’s hard drive that contains the files you want to copy. Then select the files and drag them to the folder on your storage device.

   **Important:**
   For Mac OS X users
   When you remove the storage device, always drag the removable disk icon on your desktop into the trash before you remove the storage device or you may lose data on it.
# Error Indicators

## Error Messages on the Control Panel

This section describes the meaning of messages displayed on the LCD screen.

### Color 2.5-inch display models

<table>
<thead>
<tr>
<th>Error Messages</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper jam</td>
<td>![Paper Jams](page 123)</td>
</tr>
<tr>
<td>Printer error. Turn power off and then on again. For details, see your documentation.</td>
<td>Turn the product off and then back on. Make sure that no paper is still in the product. If the error message still appears, contact Epson support.</td>
</tr>
<tr>
<td>Communication error. Make sure the computer is connected, then try again.</td>
<td>Make sure the computer is connected correctly. If the error messages still appears, make sure that scanning software is installed on your computer and that the software settings are correct.</td>
</tr>
<tr>
<td>A printer’s ink pad is nearing the end of its service life. Please contact Epson Support.</td>
<td>Press * button to resume printing. The message will be displayed until the ink pad is replaced. Contact Epson support to replace ink pads before the end of their service life. When the ink pads are saturated, the product stops and Epson support is required to continue printing.</td>
</tr>
<tr>
<td>A printer’s ink pad is at the end of its service life. Please contact Epson Support.</td>
<td>Contact Epson support to replace ink pads.</td>
</tr>
<tr>
<td>Cannot recognize USB device.</td>
<td>Make sure USB device has been inserted correctly.</td>
</tr>
<tr>
<td>Cannot recognize the device. Make sure the connected device is capable of storage.</td>
<td>Make sure the storage disk has been inserted correctly.</td>
</tr>
<tr>
<td>No dial tone detected. Try Check Fax Connection.</td>
<td>Make sure the phone cable is connected correctly and the phone line works. ![Connecting to a Phone Line](page 64) If you connected the product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, turn off the Dial Tone Detection. ![Press Ø and then 重要. Then select Fax Settings &gt; Communication &gt; Dial Tone Detection.](page 228)</td>
</tr>
<tr>
<td>The combination of IP address and subnet mask is invalid. See your documentation.</td>
<td>Refer the online Network Guide.</td>
</tr>
<tr>
<td>Recovery Mode</td>
<td>The firmware update has failed. You will need to re-attempt the firmware update. Ready a USB cable and visit your local Epson website for further instructions.</td>
</tr>
</tbody>
</table>
### Monochrome 2-line display models

<table>
<thead>
<tr>
<th>Error Messages</th>
<th>Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper jam</td>
<td>Remove the jammed paper.</td>
</tr>
<tr>
<td>Press OK. If the error does not</td>
<td>with the jammed paper.</td>
</tr>
<tr>
<td>clear, remove the paper by hand.</td>
<td>“Paper Jams” on page 123</td>
</tr>
<tr>
<td>Paper jam in the ADF. Remove the</td>
<td></td>
</tr>
<tr>
<td>jammed paper.</td>
<td></td>
</tr>
<tr>
<td>Communication error. Make sure the</td>
<td>Make sure the computer is connected correctly. If the error messages</td>
</tr>
<tr>
<td>cable is connected, then try again.</td>
<td>still appear, make sure that scanning software is installed on your</td>
</tr>
<tr>
<td></td>
<td>computer and that the software settings are correct.</td>
</tr>
<tr>
<td>Printer error</td>
<td>Turn the product off and then back on. Make sure that no paper is still</td>
</tr>
<tr>
<td>Paper jam. Open the scanner unit</td>
<td>the product. If the error message still appears, contact Epson support.</td>
</tr>
<tr>
<td>and remove the paper, then turn off</td>
<td></td>
</tr>
<tr>
<td>the printer. See your documentation.</td>
<td></td>
</tr>
<tr>
<td>ADF Error. Remove any objects or</td>
<td></td>
</tr>
<tr>
<td>documents inside ADF. Turn power</td>
<td></td>
</tr>
<tr>
<td>off. See documentation.</td>
<td></td>
</tr>
<tr>
<td>Printer error</td>
<td></td>
</tr>
<tr>
<td>See your documentation.</td>
<td></td>
</tr>
<tr>
<td>Scanner error</td>
<td></td>
</tr>
<tr>
<td>See your documentation.</td>
<td></td>
</tr>
<tr>
<td>A fax error has occurred.</td>
<td></td>
</tr>
<tr>
<td>See your documentation.</td>
<td></td>
</tr>
<tr>
<td>A printer’s ink pad is nearing the</td>
<td>Press OK to resume printing. The message will be displayed until the ink</td>
</tr>
<tr>
<td>end of its service life. Please</td>
<td>pad is replaced.</td>
</tr>
<tr>
<td>contact Epson Support.</td>
<td>Contact Epson support to replace ink pads before the end of their</td>
</tr>
<tr>
<td></td>
<td>service life. When the ink pads are saturated, the product stops and</td>
</tr>
<tr>
<td></td>
<td>Epson support is required to continue printing.</td>
</tr>
<tr>
<td>A printer’s ink pad is at the end</td>
<td>Contact Epson support to replace the ink pad.</td>
</tr>
<tr>
<td>of its service life. Please contact</td>
<td></td>
</tr>
<tr>
<td>Epson Support.</td>
<td></td>
</tr>
<tr>
<td>No dial tone. Fax job incomplete.</td>
<td>Make sure the phone cable is connected correctly and the phone line</td>
</tr>
<tr>
<td>Make sure the phone cable is</td>
<td>works.</td>
</tr>
<tr>
<td>connected correctly and the phone</td>
<td>“Connecting to a Phone Line” on page 64</td>
</tr>
<tr>
<td>line works.</td>
<td>If you connected the product to a PBX (Private Branch Exchange) phone</td>
</tr>
<tr>
<td></td>
<td>line or Terminal Adapter, turn off the Dial Tone Detection.</td>
</tr>
<tr>
<td></td>
<td>Press and then . Then select Fax Settings &gt; Communication &gt; Dial Tone</td>
</tr>
<tr>
<td>Recovery Mode</td>
<td>The firmware update has failed. You will need to re-attempt the firmware</td>
</tr>
<tr>
<td></td>
<td>update. Ready a USB cable and visit your local Epson website for further</td>
</tr>
<tr>
<td></td>
<td>instructions.</td>
</tr>
</tbody>
</table>
Troubleshooting for Printing/Copying

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving, the control panel, or the status monitor. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printing problem not related to print quality, or a paper feeding problem, or if the product does not print at all, refer to the appropriate section.

To solve a problem, you may need to cancel printing.
➤ “Canceling printing” on page 34
Checking product status

If a problem occurs while printing, an error message will appear in the status monitor window.

If an error message appears indicating the product’s ink pads are nearing the end of their service life, contact Epson support to replace them. The message will be displayed at regular intervals until the ink pads are replaced. When the product’s ink pads are saturated, the product stops and Epson support is required to continue printing.

For Windows

There are two ways to access EPSON Status Monitor 3:

- Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the following section:
  - “From the shortcut icon on the taskbar” on page 30

- Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button.

When you access EPSON Status Monitor 3, the following window appears:

![EPSON Status Monitor 3 window]

Note:

- If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

- Depending on current settings, the simplified status monitor may be displayed. Click the Details button to display the window above.

EPSON Status Monitor 3 provides the following information:
Current Status:
If the ink is low or expended, the How to button appears in the EPSON Status Monitor 3 window. Clicking How to displays ink cartridge replacement instructions and moves the ink cartridge holder to the ink cartridge replacement position.

Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the ink cartridge status.

Information:
You can view information about the installed ink cartridges by clicking Information.

Technical Support:
Click Technical Support to access the Epson technical support website.

Print Queue:
You can view Windows Spooler by clicking Print Queue.

For Mac OS X
Follow these steps to access EPSON Status Monitor.

   ➤ “Accessing the printer driver for Mac OS X” on page 30

2. Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

You can also use this utility to check the ink cartridge status before printing. EPSON Status Monitor displays the ink cartridge status at the time it was opened. To update the ink cartridge status, click Update.
When ink is low or expended, a **How to** button appears. Click **How to**, and EPSON Status Monitor will lead you step by step through the ink cartridge replacement procedure.

![EPSON Status Monitor](image)

**Paper Jams**

⚠️ **Caution:**

Never touch the buttons on the control panel while your hand is inside the product.

---

**Note:**

- Cancel the print job if prompted by a message from the LCD screen or the printer driver.
- After you have removed the jammed paper, press the button indicated in the LCD screen.
Removing jammed paper from inside the product

1. Open the scanner unit.

2. Remove all of the paper inside, including any torn pieces.

3. Close the scanner unit slowly.

**Important:**
Do not lift up the scanner unit when the document cover is open.
Removing jammed paper from the Automatic Document Feeder (ADF)

**Note:**
The availability of this feature varies by product.

1. Remove the stack of paper from the ADF input tray.

2. Open the ADF cover.

3. Carefully remove the jammed paper.

**Important:**
Make sure you open the ADF cover before removing jammed paper. If you do not open the cover, the product may be damaged.
Open the Automatic Document Feeder (ADF).

Remove all of the paper inside, including any torn pieces.

Close the Automatic Document Feeder (ADF).

Raise the ADF input tray.
Carefully remove the jammed paper.

Return the ADF input tray to its original position, and close the ADF cover.

Preventing paper jams

If your paper jams frequently, check the following.

- The paper is smooth, not curled or wrinkled.
- You are using high-quality paper.
- The printable side of the paper is face up in the rear paper feed.
- The paper stack was fanned before loading.
- For plain paper, do not load paper above the line just under the \( \text{arrow mark} \) inside the edge guide. For Epson special media, make sure the number of sheets is less than the limit specified for the media.
  ➤ “Selecting Paper” on page 19
- The edge guides are snug against the edges of the paper.
- The product is on a flat, stable surface that extends beyond the base in all directions. The product will not operate properly if it is tilted.

Reprinting after a paper jam (for Windows only)

After you cancel the print job because of a paper jam, you can reprint it without reprinting pages that have already been printed.

1. Solve the paper jam.
   ➤ “Paper Jams” on page 123

2. Access the printer settings.
   ➤ “Accessing the printer driver for Windows” on page 29

3. Select the Print Preview check box in the Main window of your printer driver.
Troubleshooting for Printing/Copying

Make the settings that you want to use to print.

4

Click OK to close the printer settings window, and then print your file. Print Preview window opens.

5

Select a page that has already been printed in the page list box on the left side, and then select Remove Page from the Print Options menu. Repeat this step for all the pages that have already been printed.

6

Click Print on the Print Preview window.

7

Print Quality Help

If you are having print quality problems, then compare it with the illustrations below. Click the caption under the illustration that best resembles your prints.

<table>
<thead>
<tr>
<th>Good sample</th>
<th>Good sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Horizontal banding&quot; on page 129</td>
<td></td>
</tr>
<tr>
<td>&quot;Vertical banding or misalignment&quot; on page 129</td>
<td></td>
</tr>
<tr>
<td>&quot;Incorrect or missing colors&quot; on page 129</td>
<td></td>
</tr>
<tr>
<td>&quot;Blurry or smeared print&quot; on page 130</td>
<td></td>
</tr>
</tbody>
</table>
Horizontal banding

- Make sure the printable side (the whiter or glossier side) of the paper is face up in the rear paper feed.
- Run the Head Cleaning utility to clear any clogged ink nozzles.  
  ➤ “Cleaning the Print Head” on page 105
- For best results, use up ink cartridge within six months of opening the package.
- Try to use genuine Epson ink cartridges.
- Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in the product.  
  ➤ “Selecting Paper” on page 19
- If banding appears at intervals of 2.5 cm, run the Print Head Alignment utility.  
  ➤ “Aligning the Print Head” on page 106
- If a moire (cross-hatch) pattern appears on your copy, change the Reduce/Enlarge setting in the LCD menu or shift the position of your original.
- If there is problem with copy quality, clean the exterior of the product.  
  ➤ “Cleaning the exterior of the product” on page 110

Vertical banding or misalignment

- Make sure the printable side (the whiter or glossier side) of the paper is face up in the rear paper feed.
- Run the Head Cleaning utility to clear any clogged ink nozzles.  
  ➤ “Cleaning the Print Head” on page 105
- Run the Print Head Alignment utility.  
  ➤ “Aligning the Print Head” on page 106
- For Windows, clear the High Speed check box from the More Options window in your printer driver. See the online help for details.  
  For Mac OS X, select Off from the High Speed Printing. To display the High Speed Printing, click through the following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your product (in the Printers list box), Options & Supplies, and then Driver.
- Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in the product.  
  ➤ “Selecting Paper” on page 19
- If there is problem with copy quality, clean the exterior of the product.  
  ➤ “Cleaning the exterior of the product” on page 110

Incorrect or missing colors

- For Windows, clear the Grayscale setting in the Main window in your printer driver.  
  For Mac OS X, clear the Grayscale setting in Print Settings in the Print dialog box in your printer driver. See the online help for details.
Adjust the color settings in your application or in your printer driver settings. For Windows, check the More Options window. For Mac OS X, check the Color Options dialog box from the Print dialog box. See the online help for details.

Run the Head Cleaning utility to clear any clogged ink nozzles.

If you have just replaced an ink cartridge, make sure the date on the box. If you have not used the product for a long time, Epson recommends replacing the ink cartridges.

Try to use genuine Epson ink cartridges and paper recommended by Epson.

Blurry or smeared print

Try to use genuine Epson ink cartridges and paper recommended by Epson.

Make sure the product is on a flat, stable surface that extends beyond the base in all directions. The product will not operate properly if it is tilted.

Make sure your paper is not damaged, dirty, or too old.

Make sure your paper is dry and the printable side (the whiter or glossier side) is face up in the rear paper feed.

If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in the product.

Remove each sheet from the output tray as it is printed.

Do not touch or allow anything to come into contact with the printed side of paper with a shiny finish. To handle your prints, follow the instructions of the paper.

Run the Head Cleaning utility to clear any clogged ink nozzles.

Run the Print Head Alignment utility.

If the paper is smeared with ink after printing, clean the interior of the product.

If there is problem with copy quality, clean the exterior of the product.
Miscellaneous Printout Problems

Incorrect or garbled characters

- Clear any stalled print jobs.
  ➔ "Canceling printing" on page 34
- Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.
- Uninstall the printer driver, then reinstall it.
  ➔ "Uninstalling Your Software" on page 114

Incorrect margins

- Make sure that the paper is loaded into the rear paper feed correctly.
  ➔ "Loading Paper and Envelopes" on page 22
- Check the margin settings in your application. Make sure that the margins are within the printable area of the page.
  ➔ "Printable area" on page 148
- Make sure the printer driver settings are appropriate for the paper size you are using.
  For Windows, check the Main window.
  For Mac OS X, check the Page Setup dialog box or Print dialog box.
- Uninstall the printer driver, then reinstall it.
  ➔ "Uninstalling Your Software" on page 114

Printout has a slight slant

- Make sure that the paper is loaded into the rear paper feed correctly.
  ➔ "Loading Paper and Envelopes" on page 22
- If Draft is selected in Quality in the Main window in your printer driver (for Windows), or Fast Economy is selected in Print Quality in Print Settings (for Mac OS X), select another setting.

Size or position of copied image is incorrect

- Make sure the paper size, layout, or reduce/enlarge setting selected in the control panel matches the paper used.
- If the edges of the copy are cropped off, move the original slightly away from the corner.
- Clean the scanner glass.
  ➔ "Cleaning the exterior of the product" on page 110
Inverted image

- For Windows, clear the Mirror Image check box from the More Options window of your printer driver, or turn off the Mirror Image setting in your application.
  For Mac OS X, clear the Mirror Image check box in Print Settings in the Print dialog box of your printer driver, or turn off the Mirror Image setting in your application.
  For instructions, see the online help for your printer driver or for your application.

- Uninstall the printer driver, then reinstall it.
  ➔ “Uninstalling Your Software” on page 114

Blank pages print

- Make sure the printer driver settings are appropriate for the paper size you are using.
  For Windows, check the Main window.
  For Mac OS X, check the Page Setup dialog box or Print dialog box.

- For Windows, check the Skip Blank Page setting by clicking the Extended Settings button on the Maintenance window of the printer driver.
  For Mac OS X, select On from the Skip Blank Page. To display the Skip Blank Page, click through the following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your product (in the Printers list box), Options & Supplies, and then Driver.

- Uninstall the printer driver, then reinstall it.
  ➔ “Uninstalling Your Software” on page 114

Printed side is smeared or scuffed

- If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

- Make several copies without placing a document on the scanner glass.
  ➔ “Cleaning the interior of the product” on page 111

- Uninstall the printer driver, then reinstall it.
  ➔ “Uninstalling Your Software” on page 114

Printing is too slow

- Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in the product.
  ➔ “Selecting Paper” on page 19

- For Windows, choose a lower Quality in the printer driver Main window.
  For Mac OS X, choose a lower Print Quality in the Print Settings dialog box from your printer driver’s Print dialog box.
  ➔ “Accessing the printer driver for Windows” on page 29
  ➔ “Accessing the printer driver for Mac OS X” on page 30

- Close any unnecessary applications.
Troubleshooting for Printing/Copying

- If you print continuously for an extended period, the printing may be extremely slow. This is to slow down the printing speed and prevent the product mechanism from overheating and being damaged. If this happens, you can continue to print, but we recommend stopping and leaving the product idle for at least 30 minutes with the power on. (The product does not recover with the power off.) After you restart, the product will print at normal speed.

- Uninstall the printer driver, then reinstall it.
  ➔ “Uninstalling Your Software” on page 114

If you try all of the methods above and cannot solve the problem, see the following:
  ➔ “Increasing the Print Speed (For Windows Only)” on page 136

Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

- The paper is not curled or creased.

- The paper is not too old. See the instructions that came with the paper for more information.

- For plain paper, do not load paper above the line just under the ▲ arrow mark inside the edge guide. For Epson special media, make sure the number of sheets is less than the limit specified for the media.
  ➔ “Selecting Paper” on page 19

- Paper is not jammed inside the product. If it is, remove the jammed paper.
  ➔ “Paper Jams” on page 123

- The ink cartridges are not expended. If a cartridge is expended, replace it.
  ➔ “Replacing an Ink Cartridge” on page 98

- You have followed any special loading instructions that came with your paper.

Multiple pages feed

- For plain paper, do not load paper above the line just under the ▲ arrow mark inside the edge guide. For Epson special media, make sure the number of sheets is less than the limit specified for the media.
  ➔ “Selecting Paper” on page 19

- Make sure the edge guides are snug against the edges of the paper.

- Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite side before loading.

- Remove the stack of paper and make sure that the paper is not too thin.
  ➔ “Paper” on page 147

- Fan the edges of the stack to separate the sheets, then reload the paper.
If too many copies of a file are being printed, check the Copies setting in your printer driver as follows, and also check in your application.
For Windows, check the Copies setting on the Main window.
Mac OS X, check the Copies setting in the Print dialog.

**Paper is improperly loaded**

If you have loaded the paper too far into the product, the product cannot feed the paper correctly. Turn the product off and gently remove the paper. Then turn the product on and reload the paper correctly.

**Paper is not ejected fully or is wrinkled**

- If the paper does not eject fully, press one of the buttons to eject the paper. If the paper is jammed inside the product, remove it by referring to the following section.
  ➤ “Paper Jams” on page 123
- If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

*Note:
Store any unused paper in its original packaging in a dry area.*

**The Product Does Not Print**

**All lights are off**

- Press the button to make sure the product is on.
- Make sure that the power cord is securely plugged in.
- Make sure that your outlet works and is not controlled by a wall switch or timer.

**Only the power light is on**

- Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.
- If you are using the USB interface, make sure your cable meets the USB or Hi-Speed USB standards.
- If you are connecting the product to your computer via a USB hub, connect the product to the first-tier hub from your computer. If the printer driver is still not recognized on your computer, try to directly connect the product to your computer without the USB hub.
- If you are connecting the product to your computer via a USB hub, make sure the USB hub device is recognized by your computer.
- If you are trying to print a large image, your computer may not have enough memory. Try reducing the resolution of your image or printing the image at a smaller size. You may need to install more memory in your computer.
An ink error is indicated after you replace the cartridge

1. Open the scanner unit.

⚠️ Important:
Do not lift up the scanner unit when the document cover is open.

2. Make sure the ink cartridge holder is at the ink cartridge replacement position.

Note:
If the ink cartridge holder is at the far right position, press ←, select Maintenance, and then select Ink Cartridge Replacement.
Remove and reinsert the ink cartridge and then continue with the ink cartridge installation. Make sure the top surface of the ink cartridges align.

Close the scanner unit slowly, and press OK in the control panel.

Increasing the Print Speed (For Windows Only)

Print speed may be increased by selecting certain settings in the Extended Settings window when the printing speed is slow. Click the Extended Settings button on your printer driver’s Maintenance window.
The following dialog box appears.

![Extended Settings dialog box]

Select the following check boxes and print speed may be increased.

- High Speed Copies
- Always spool RAW datatype
- Page Rendering Mode
- Print as Bitmap

For more details on each item, see the online help.

**Other Problem**

**Printing plain papers quietly**

When plain paper is selected for the paper type and Standard (Windows) or Normal (Mac OS X) is selected as for quality in the printer driver, the product prints at high speed. Try choosing Quiet Mode for quieter operation which will reduce the print speed.

For Windows, select the Quiet Mode check box in the Main window of your printer driver. For Mac OS X, select On from the Quiet Mode. To display the Quiet Mode, click through the following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your product (in the Printers list box), Options & Supplies, and then Driver.
Troubleshooting for Scanning

Problems Indicated by Messages on the LCD Screen or Status Light

- Make sure the product is connected to your computer properly.
- Turn off the product and turn it on again. If the problem is not solved, the product may be malfunctioning, or the light source in the scanner unit may need to be replaced. Contact your dealer.
- Make sure the scanning software is fully installed. See the paper manual for instructions on installing the scanning software.

Problems When Starting a Scan

- Check the status light and make sure the product is ready to scan.
- Make sure your cables are securely connected to the product and a working electrical outlet. If necessary, test your product’s AC adapter by plugging in another electrical device and turning it on.
- Turn off the product and computer, and then check the interface cable connection between them to make sure it is secure.
- Make sure you select the correct product if a scanner list appears when starting to scan.
  
  Windows:
  When you start Epson Scan using the EPSON Scan icon, and the Select Scanner list is displayed, make sure you select the model of your product.
  
  Mac OS X:
  When you start Epson Scan from the Applications folder and the Select Scanner list is displayed, make sure you select the model of your product.
  
- Connect the product directly to the computer’s external USB port or through one USB hub only. The product may not work properly when connected to the computer through more than one USB hub. If the problem persists, try connecting the product directly to the computer.
- If more than one product is connected to your computer, it may not work. Connect only the product you want to use, and then try scanning again.
- If the scanning software does not work properly, uninstall the software first and then reinstall it as described in the paper manual.
  ➤ “Uninstalling Your Software” on page 114

Using the Automatic Document Feeder (ADF)

- Check the ADF light and make sure the ADF is ready to scan.
Troubleshooting for Scanning

- Make sure there are no originals on the scanner glass.
- If the document cover or ADF cover is open, close it and try scanning again.
- Make sure you have selected either Office Mode or Professional Mode in Epson Scan.
- Make sure your cables are securely connected to the product and a working electrical outlet.
- If the ADF light is on and your originals are not fed, check that there is no foreign object inside the hole on the left front corner of the scanner glass.

Using the button

**Note:** Depending on the product, the scanning function may not be available when using the button.

- Check if you have assigned a program to the button.
  - “Epson Event Manager” on page 62
- Make sure Epson Scan and Epson Event Manager are installed correctly.
- If you have clicked the Keep Blocking button in the Windows Security Alert window during or after installation of the Epson Software, unblock Epson Event Manager.
  - “How to unblock Epson Event Manager” on page 139
- Mac OS X:
  - Make sure you are logged on as the user who installed the scanning software. Other users must first start Epson Scanner Monitor in the Applications folder and then press a button to scan.

How to unblock Epson Event Manager

1. Click Start or the start button, and then point to Control Panel.
2. Do one of the following.
   - Windows 7: Select System and Security.
   - Windows XP: Select Security Center.
3. Do one of the following.
   - Windows 7 and Windows Vista: Select Allow a program through Windows Firewall.
   - Windows XP: Select Windows Firewall.
Do one of the following.

- **Windows 7:** Confirm that the check box for EEventManager Application is selected in the Allowed programs and features list.

- **Windows Vista:** Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected in the Program or port list.

- **Windows XP:** Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected in the Programs and Services list.

Click OK.

---

**Using scanning software other than Epson Scan driver**

- If you are using any TWAIN-compliant programs, such as Adobe Photoshop Elements, make sure that the correct product is selected as the Scanner or Source setting.

- If you cannot scan using any TWAIN-compliant scanning programs, such as Adobe Photoshop Elements, uninstall the TWAIN-compliant scanning program and then reinstall it.

  ➤ “Uninstalling Your Software” on page 114

---

**Problems When Feeding Paper**

**The paper gets dirty**

You may need to clean the product.

➤ “Cleaning the Product” on page 110

**Multiple sheets of paper are fed**

- If you load unsupported paper, the product may feed more than one sheet of paper at a time.
  
  ➤ “Automatic Document Feeder (ADF) specifications” on page 150

- You may need to clean the product.
  
  ➤ “Cleaning the Product” on page 110

**The paper jams in the Automatic Document Feeder (ADF)**

Remove the jammed paper inside the ADF.

➤ “Removing jammed paper from the Automatic Document Feeder (ADF)” on page 125
Problems With Scanning Time

- Computers with Hi-Speed external USB ports can scan faster than those with external USB ports. If you are using a Hi-Speed external USB port with your product, make sure it meets the system requirements.
  ➤ “System Requirements” on page 146

- Scanning at a high resolution takes a long time.

Problems With Scanned Images

Scan quality is unsatisfactory

Scan quality can be improved by changing the current settings or adjusting the scanned image.
  ➤ “Image Adjustment Features” on page 45

An image on the back of your original appears in your scanned image

If your original is printed on thin paper, images on the back may be visible to the product and appear in your scanned image. Try scanning the original with a piece of black paper placed on the back of it. Also make sure the Document Type and Image Type settings are correct for your original.

Characters are distorted or blurred

- In Office Mode or Home Mode, select the Text Enhancement check box.

- Adjust the Threshold setting.
  
  Home Mode:
  Select Black & White as the Image Type setting, click the Brightness button, and then try adjusting the Threshold setting.

  Office Mode:
  Select Black & White as the Image Type setting, and then try adjusting the Threshold setting.

  Professional Mode:
  Select Black & White as the Image Type setting and click the + (Windows) or ▶ (Mac OS X) button next to Image Type. Make the appropriate Image Option setting and then try adjusting the Threshold setting.

- Increase the resolution setting.

Characters are not recognized correctly when converted into editable text (OCR)

Place the document so that it is straight on the scanner glass. If the document is skewed, it may not be recognized correctly.
Ripple patterns appear in your scanned image

A ripple or cross-hatch pattern (known as moiré) may appear in a scanned image of a printed document.

- Rotate your original document.
- Rotate the scanned image using the application software after scanning.
- Select the Descreening check box.
- In Professional Mode, change a resolution setting and scan again.

Uneven color, smears, dots, or straight lines appear in your image

You may need to clean the interior of the product.

⇒ “Cleaning the Product” on page 110

The scanning area or direction is unsatisfactory

The edges of your original are not scanned

- If you are scanning using thumbnail preview in Home Mode or Professional Mode, move the document or photo 6 mm (0.2 inch) away from the horizontal and vertical edges of the scanner glass to avoid cropping.

- If you are scanning using the button or using normal preview in Office Mode, Home Mode, or Professional Mode, move the document or photo about 3 mm (0.12 inch) away from the horizontal and vertical edges of the scanner glass to avoid cropping.
Multiple documents are scanned into a single file

Position documents at least 20 mm (0.8 inch) apart from each other on the scanner glass.

Cannot scan the area you want

Depending on the documents, you may not be able to scan the area you want. Use normal preview in Office Mode, Home Mode, or Professional Mode and create marquees on the area you want to scan.

Cannot scan in the direction you want

Click Configuration, select the Preview tab, and then clear the Auto Photo Orientation check box. Then, place your documents correctly.

Problems Remain After Trying All Solutions

If you have tried all the solutions and have not solved the problem, initialize the Epson Scan settings.

Click Configuration, select the Other tab, and then click Reset All.
Troubleshooting for Faxing

Cannot send and receive fax

- Make sure the phone cable is connected correctly and check that the phone line works. You can check the line status by using the **Check Fax Connection** function.
  ➤ “Connecting to a Phone Line” on page 64

- If the fax did not send, make sure that the recipient’s fax machine is turned on and working.

- If this product is not connected to a phone and you want to receive faxes automatically, make sure you turn on auto answer.
  ➤ “Receiving Faxes” on page 75

- If you are using the Automatic Document Feeder, check that the ADF light is on. Make sure there are no originals on the scanner glass.

- If the ADF light is on and your originals are not fed, check that there is no foreign object inside the hole on the left front corner of the scanner glass.

- If you connected the product to a DSL phone line, you must install a DSL filter on the line otherwise you cannot fax. Contact your DSL provider for the necessary filter.

- If you connected this product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, turn off **Dial Tone Detection**.
  ➤ “Fax Mode” on page 82

- Transmission speed may be the cause of the problem. Choose a slower **Fax Speed** setting.
  ➤ “Fax Mode” on page 82

- Make sure that **ECM** is turned on. Color faxes cannot be sent and received when **ECM** is off.
  ➤ “Fax Mode” on page 82

Quality problems (sending)

- Clean the scanner glass and Automatic Document Feeder (ADF).
  ➤ “Cleaning the exterior of the product” on page 110

- If the fax you sent was faint or not clear, change the **Resolution** (or **Quality** depending on your model) or **Contrast** in the fax settings menu.
  ➤ “Fax Mode” on page 82

- Make sure that **ECM** is turned on.
  ➤ “Fax Mode” on page 82
Quality problems (receiving)

- Make sure that ECM is turned on.
  ➤ “Fax Mode” on page 82

Answering machine cannot answer voice calls

- When auto answer is turned on and an answering machine is connected to the same phone line as this product, set the number of rings to answer for receiving faxes to a higher number than the number of rings for the answering machine.
  ➤ “Receiving Faxes” on page 75

Incorrect time

- The clock may run fast/slow or may be reset after a power failure, or the power is left off for a long time. Set the correct time.
  ➤ “Setting/Changing Time and Region” on page 108
Product Information

Ink Cartridges

You can use the following ink cartridges with this product:

<table>
<thead>
<tr>
<th>Ink Cartridge</th>
<th>Part numbers</th>
<th>For Australia/New Zealand</th>
<th>WF-2511</th>
<th>WF-2528</th>
</tr>
</thead>
<tbody>
<tr>
<td>WF-2510</td>
<td>16/16XL</td>
<td>200/200XL</td>
<td>193/198</td>
<td>190/190XL</td>
</tr>
<tr>
<td>WF-2520</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2530</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2540</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2510</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2520</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2530</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2540</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2511</td>
<td>16/16XL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2521</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2531</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2541</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2528</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2538</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WF-2548</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Black, Cyan, Magenta, Yellow

Note: Not all cartridges are available in all regions.

For best results, use up ink cartridge within six months of opening the package.

Storage:
-20 to 40 °C (-4 to 104 °F)
1 month at 40 °C (104 °F)
Freezing:
-12 °C (10.4 °F)

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

System Requirements

For Windows

<table>
<thead>
<tr>
<th>System</th>
<th>PC Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7 (32-bit, 64-bit), Vista (32-bit, 64-bit), XP SP1 or higher(32-bit), or XP Professional x64 Edition</td>
<td>Hi-Speed USB</td>
</tr>
</tbody>
</table>
For Mac OS X

<table>
<thead>
<tr>
<th>System</th>
<th>PC Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X 10.5.8, 10.6.x, 10.7.x</td>
<td>Hi-Speed USB</td>
</tr>
</tbody>
</table>

Note:
The UNIX File System (UFS) for Mac OS X is not supported.

Technical Specifications

Note:
Specifications are subject to change without notice.

Printer specifications

<table>
<thead>
<tr>
<th>Paper path</th>
<th>Rear paper feed, top entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>11 mm (0.4in.)</td>
</tr>
</tbody>
</table>

Paper

Note:
- Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot attest to the quality of any non-Epson brand or type of paper. Always test samples of paper stock before purchasing large quantities or printing large jobs.
- Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter problems, switch to a higher grade of paper.

Single sheets:
## Size

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 210 × 297 mm</td>
<td></td>
</tr>
<tr>
<td>10 × 15 cm (4 × 6 in.)</td>
<td></td>
</tr>
<tr>
<td>13 × 18 cm (5 × 7 in.)</td>
<td></td>
</tr>
<tr>
<td>A6 105 × 148 mm</td>
<td></td>
</tr>
<tr>
<td>A5 148 × 210 mm</td>
<td></td>
</tr>
<tr>
<td>BS 182 × 257 mm</td>
<td></td>
</tr>
<tr>
<td>9 × 13 cm (3.5 × 5 in.)</td>
<td></td>
</tr>
<tr>
<td>13 × 20 cm (5 × 8 in.)</td>
<td></td>
</tr>
<tr>
<td>20 × 25 cm (8 × 10 in.)</td>
<td></td>
</tr>
<tr>
<td>16:9 wide size (102 × 181 mm)</td>
<td></td>
</tr>
<tr>
<td>100 × 148 mm</td>
<td></td>
</tr>
<tr>
<td>Letter 8 1/2 × 11 in.</td>
<td></td>
</tr>
<tr>
<td>Legal 8 1/2 × 14 in.</td>
<td></td>
</tr>
</tbody>
</table>

### Paper types

- Plain paper or special paper distributed by Epson

### Thickness (for plain paper)

- 0.08 to 0.11 mm (0.003 to 0.004 in.)

### Weight (for plain paper)

- 64 g/m² (17 lb) to 90 g/m² (24 lb)

## Envelopes:

### Size

<table>
<thead>
<tr>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope #10 4 1/8 × 9 1/2 in.</td>
<td></td>
</tr>
<tr>
<td>Envelope DL 110 × 220 mm</td>
<td></td>
</tr>
<tr>
<td>Envelope C6 114 × 162 mm</td>
<td></td>
</tr>
</tbody>
</table>

### Paper types

- Plain paper

### Weight

- 75 g/m² (20 lb) to 90 g/m² (24 lb)

## Printable area

Highlighted portions show printable area.

### Single sheets:

<table>
<thead>
<tr>
<th></th>
<th>Normal</th>
<th>Borderless</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

148
Envelopes:

Note:
Depending on the type of paper, print quality may decline in the top and bottom areas of the print, or the area may be smeared.

Scanner specifications

<table>
<thead>
<tr>
<th>Scanner type</th>
<th>Flatbed color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photoelectric device</td>
<td>CIS</td>
</tr>
</tbody>
</table>
## Effective pixels
10200 × 14040 pixels at 1200 dpi
Scanning area may be restricted if resolution setting is large.

## Document size
216 × 297 mm (8.5 × 11.7 inches) A4 or US letter size

## Scanning resolution
1200 dpi (main scan)
2400 dpi (sub scan)

## Output resolution
50 to 4800, 7200, and 9600 dpi
(50 to 4800 dpi in 1 dpi increments)

## Image data
16 bits per pixel per color internal
8 bits per pixel per color external (maximum)

## Light source
LED

### Automatic Document Feeder (ADF) specifications

<table>
<thead>
<tr>
<th>Paper input</th>
<th>Face-up loading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper output</td>
<td>Face-down ejection</td>
</tr>
<tr>
<td>Paper size</td>
<td>A4, Letter, Legal</td>
</tr>
<tr>
<td>Paper types</td>
<td>Plain paper</td>
</tr>
<tr>
<td>Paper weight</td>
<td>64 to 95 g/m²</td>
</tr>
<tr>
<td>Paper capacity</td>
<td>Total thickness of 3 mm, up to about 30 sheets (Letter, A4) 10 sheets (Legal)</td>
</tr>
</tbody>
</table>

### Fax specifications

<table>
<thead>
<tr>
<th>Fax type</th>
<th>Walk-up black and white and color fax capability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support line</td>
<td>Household phone line</td>
</tr>
<tr>
<td>Speed</td>
<td>Up to 33.6 kbps</td>
</tr>
<tr>
<td>Resolution</td>
<td>Monochrome</td>
</tr>
<tr>
<td></td>
<td>Standard: 203 × 98 dpi</td>
</tr>
<tr>
<td></td>
<td>Fine: 203 × 196 dpi</td>
</tr>
<tr>
<td></td>
<td>Photo: 203 × 196 dpi</td>
</tr>
<tr>
<td></td>
<td>Color</td>
</tr>
<tr>
<td></td>
<td>Fine: 200 × 200 dpi</td>
</tr>
<tr>
<td></td>
<td>Photo: 200 × 200 dpi</td>
</tr>
<tr>
<td>Error correction mode</td>
<td>CCITU/ITU Group 3 fax with error correction mode</td>
</tr>
<tr>
<td>Speed dial numbers</td>
<td>Up to 60</td>
</tr>
<tr>
<td>Page memory</td>
<td>Up to 180 pages (ITU-T No.1 chart)</td>
</tr>
<tr>
<td>Redial</td>
<td>2 times (with 1 minute interval)</td>
</tr>
</tbody>
</table>
## Network interface specification

See below for information on the network interface available with your product.

► “Available Features” on page 14

<table>
<thead>
<tr>
<th>Wi-Fi</th>
<th>Standard:</th>
<th>IEEE 802.11b/g/n*1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security:</td>
<td>WEP (64/128bit)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>WPA-PSK (TKIP/AES)</td>
<td>*2</td>
</tr>
<tr>
<td>Frequency Band:</td>
<td>2.4 GHz</td>
<td></td>
</tr>
<tr>
<td>Communication Mode:</td>
<td>Infrastructure mode, Ad hoc mode</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ethernet</th>
<th>Standard:</th>
<th>IEEE802.3i/u, IEEE802.3az*3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Mode:</td>
<td>Ethernet 100BASE-TX/10BASE-T</td>
<td></td>
</tr>
</tbody>
</table>

*1 Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.

*2 Complies with WPA2 with support for WPA/WPA2 Personal.

*3 The connected device should comply with IEEE802.3az.

## Mechanical

WF-2510/WF-2511

<table>
<thead>
<tr>
<th>Dimensions</th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width: 392 mm (15.4 inches)</td>
<td></td>
</tr>
<tr>
<td>Depth: 377 mm (14.8 inches)</td>
<td></td>
</tr>
<tr>
<td>Height: 177 mm (7.0 inches)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printing*</th>
<th>Width: 392 mm (15.4 inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Depth: 540 mm (21.3 inches)</td>
<td></td>
</tr>
<tr>
<td>Height: 291 mm (11.5 inches)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Weight</th>
<th>Approx. 5.0 kg (11.0 lb) without the ink cartridges and the power cord.</th>
</tr>
</thead>
</table>

* With the output tray extension extended.

WF-2520/WF-2521/WF-2528
### Dimensions

<table>
<thead>
<tr>
<th></th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>392 mm (15.4 inches)</td>
</tr>
<tr>
<td>Depth</td>
<td>377 mm (14.8 inches)</td>
</tr>
<tr>
<td>Height</td>
<td>221 mm (8.7 inches)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Printing*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>392 mm (15.4 inches)</td>
</tr>
<tr>
<td>Depth</td>
<td>540 mm (21.3 inches)</td>
</tr>
<tr>
<td>Height</td>
<td>291 mm (11.5 inches)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Approx. 5.8 kg (12.8 lb)</td>
</tr>
</tbody>
</table>

*With the output tray extension extended.

### WF-2530/WF-2531/WF-2538

<table>
<thead>
<tr>
<th></th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>392 mm (15.4 inches)</td>
</tr>
<tr>
<td>Depth</td>
<td>377 mm (14.8 inches)</td>
</tr>
<tr>
<td>Height</td>
<td>221 mm (8.7 inches)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Printing*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>392 mm (15.4 inches)</td>
</tr>
<tr>
<td>Depth</td>
<td>540 mm (21.3 inches)</td>
</tr>
<tr>
<td>Height</td>
<td>291 mm (11.5 inches)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Approx. 5.8 kg (12.8 lb)</td>
</tr>
</tbody>
</table>

*With the output tray extension extended.

### WF-2540/WF-2541/WF-2548

<table>
<thead>
<tr>
<th></th>
<th>Storage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>392 mm (15.4 inches)</td>
</tr>
<tr>
<td>Depth</td>
<td>377 mm (14.8 inches)</td>
</tr>
<tr>
<td>Height</td>
<td>221 mm (8.7 inches)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Printing*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>392 mm (15.4 inches)</td>
</tr>
<tr>
<td>Depth</td>
<td>540 mm (21.3 inches)</td>
</tr>
<tr>
<td>Height</td>
<td>291 mm (11.5 inches)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Weight</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Approx. 5.9 kg (13.0 lb)</td>
</tr>
</tbody>
</table>

*With the output tray extension extended.

### Electrical

**WF-2510/WF-2511**

<table>
<thead>
<tr>
<th></th>
<th>100-240 V Model</th>
</tr>
</thead>
</table>

152
### Product Information

<table>
<thead>
<tr>
<th>Input voltage range</th>
<th>90 to 264 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.8 to 0.5 A</td>
</tr>
<tr>
<td><strong>Power consumption</strong></td>
<td></td>
</tr>
<tr>
<td>Standalone copying</td>
<td>Approx. 11 W (ISO/IEC24712)</td>
</tr>
<tr>
<td>Ready mode</td>
<td>Approx. 4.5 W</td>
</tr>
<tr>
<td>Sleep mode</td>
<td>Approx. 2.3 W</td>
</tr>
<tr>
<td>Power off</td>
<td>Approx. 0.3 W</td>
</tr>
</tbody>
</table>

**WF-2520/WF-2521/WF-2528**

<table>
<thead>
<tr>
<th>Input voltage range</th>
<th>90 to 264 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.8 to 0.5 A</td>
</tr>
<tr>
<td><strong>Power consumption</strong></td>
<td></td>
</tr>
<tr>
<td>Standalone copying</td>
<td>Approx. 9 W (ISO/IEC24712)</td>
</tr>
<tr>
<td>Ready mode</td>
<td>Approx. 4.0 W</td>
</tr>
<tr>
<td>Sleep mode</td>
<td>Approx. 2.0 W</td>
</tr>
<tr>
<td>Power off</td>
<td>Approx. 0.3 W</td>
</tr>
</tbody>
</table>

**WF-2530/WF-2531/WF-2538**

<table>
<thead>
<tr>
<th>Input voltage range</th>
<th>90 to 264 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.8 to 0.5 A</td>
</tr>
<tr>
<td><strong>Power consumption</strong></td>
<td></td>
</tr>
<tr>
<td>Standalone copying</td>
<td>Approx. 9 W (ISO/IEC24712)</td>
</tr>
<tr>
<td>Ready mode</td>
<td>Approx. 4.5 W</td>
</tr>
<tr>
<td>Sleep mode</td>
<td>Approx. 2.2 W</td>
</tr>
<tr>
<td>Power off</td>
<td>Approx. 0.3 W</td>
</tr>
</tbody>
</table>

**WF-2540/WF-2541/WF-2548**

| **100-240 V Model**       |             |

---

153
Product Information

<table>
<thead>
<tr>
<th>Input voltage range</th>
<th>90 to 264 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated frequency range</td>
<td>50 to 60 Hz</td>
</tr>
<tr>
<td>Input frequency range</td>
<td>49.5 to 60.5 Hz</td>
</tr>
<tr>
<td>Rated current</td>
<td>0.8 to 0.5 A</td>
</tr>
<tr>
<td>Power consumption Standalone copying</td>
<td>Approx. 10 W (ISO/IEC24712)</td>
</tr>
<tr>
<td>Ready mode</td>
<td>Approx. 5.0 W</td>
</tr>
<tr>
<td>Sleep mode</td>
<td>Approx. 2.4 W</td>
</tr>
<tr>
<td>Power off</td>
<td>Approx. 0.3 W</td>
</tr>
</tbody>
</table>

**Note:**
*Check the label on the back of the product for its voltage.*

Environmental

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Operation: 10 to 35 °C (50 to 95 °F)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Storage: -20 to 40 °C (-4 to 104 °F)</td>
</tr>
<tr>
<td></td>
<td>1 month at 40 °C (104 °F)</td>
</tr>
<tr>
<td>Humidity</td>
<td>Operation:* 20 to 80% RH</td>
</tr>
<tr>
<td></td>
<td>Storage:* 5 to 85% RH</td>
</tr>
</tbody>
</table>

* Without condensation

Standards and approvals

U.S. model:

<table>
<thead>
<tr>
<th>Safety</th>
<th>UL60950-1 CAN/CSA-C22.2 No.60950-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMC</td>
<td>FCC Part 15 Subpart B Class B CAN/CSA-CEI/IEC CISPR 22 Class B</td>
</tr>
</tbody>
</table>

**WF-2510/WF-2530/WF-2540**

These equipments contains the following wireless module.

Manufacture: Askey Computer Corporation
Type: WLU6117-D69 (RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

European model:

<table>
<thead>
<tr>
<th>Low voltage directive 2006/95/EC</th>
<th>EN60950-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMC directive 2004/108/EC</td>
<td>EN55022 Class B</td>
</tr>
<tr>
<td></td>
<td>EN61000-3-2</td>
</tr>
<tr>
<td></td>
<td>EN61000-3-3</td>
</tr>
<tr>
<td></td>
<td>EN55024</td>
</tr>
<tr>
<td>R&amp;TTE directive 1999/5/EC</td>
<td>EN300 328*</td>
</tr>
<tr>
<td></td>
<td>EN301 489-1*</td>
</tr>
<tr>
<td></td>
<td>EN301 489-17*</td>
</tr>
<tr>
<td></td>
<td>TBR21</td>
</tr>
<tr>
<td></td>
<td>EN60950-1</td>
</tr>
</tbody>
</table>

* These only applies to the WF-2510/WF-2530/WF-2540

For European users:
We, Seiko Epson Corporation, hereby declare that the equipment Models, C471A, C471B, C471C, and C471D, are in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg, Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Cyprus, Greece, Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

WF-2510/WF-2530/WF-2540
Only indoor operation is permitted in France.
If used outside of own premises, general authorization is required in Italy.

Epson can not accept responsibility for any failure to satisfy the protection requirements resulting a non-recommended modification of the products.

Australian model:

<table>
<thead>
<tr>
<th>EMC</th>
<th>AS/NZS CISPR22 Class B</th>
</tr>
</thead>
</table>

WF-2510/WF-2530/WF-2540
Epson hereby declares that the equipment Models, C471A, C471B, C471C, and C471D, are in compliance with the essential requirements and other relevant provisions of AS/NZS4268. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product.

Interface

| Hi-Speed USB (Device Class for computers) |
Hi-Speed USB (for Mass storage class for external storage)*

* This is only available for WF-2540/WF-2541/WF-2548. For connecting a USB flash drive (up to 2 TB, formatted in FAT, FAT32, or exFAT). Epson cannot guarantee the operation of externally connected devices.
Where To Get Help

Technical Support Web Site

Epson’s Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting information in your product documentation. If you have a Web browser and can connect to the Internet, access the site at:

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If you need the latest drivers, FAQs, manuals, or other downloadables, access the site at:

http://www.epson.com
http://www.epson.eu/Support (Europe)

Then, select the support section of your local Epson Web site.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting information in your product documentation, contact Epson support services for assistance. If Epson support for your area is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

- Product serial number
  (The serial number label is usually on the back of the product.)

- Product model

- Product software version
  (Click About, Version Info, or similar button in the product software.)

- Brand and model of your computer

- Your computer operating system name and version

- Names and versions of the software applications you normally use with your product

Note:
Depending on the product, the dial list data for fax and/or network settings may be stored in the product’s memory. Due to breakdown or repair of a product, data and/or settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering data and/or settings even during a warranty period. We recommend that you make your own backup data or take notes.
Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:


Information on product specifications, drivers for download, and products enquiry are available.

Epson HelpDesk (Phone: +0280242008)

Our HelpDesk team can help you with the following over the phone:

- Sales enquiries and product information
- Product usage questions or problems
- Enquiries on repair service and warranty

Repair service center:

<table>
<thead>
<tr>
<th>Telephone number</th>
<th>Fax number</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>02-23416969</td>
<td>02-23417070</td>
<td>No.20, Beiping E. Rd., Zhongzheng Dist., Taipei City 100, Taiwan</td>
</tr>
<tr>
<td>02-27491234</td>
<td>02-27495955</td>
<td>1F., No.16, Sec. 5, Nanjing E. Rd., Songshan Dist., Taipei City 105, Taiwan</td>
</tr>
<tr>
<td>02-32340688</td>
<td>02-32345299</td>
<td>No.1, Ln. 359, Sec. 2, Zhongshan Rd., Zhonghe City, Taipei County 235, Taiwan</td>
</tr>
<tr>
<td>039-605007</td>
<td>039-600969</td>
<td>No.342-1, Guangrong Rd., Luodong Township, Yilan County 265, Taiwan</td>
</tr>
<tr>
<td>038-312966</td>
<td>038-312977</td>
<td>No.87, Guolian 2nd Rd., Hualien City, Hualien County 970, Taiwan</td>
</tr>
<tr>
<td>03-2810606</td>
<td>03-2810707</td>
<td>No.413, Huannan Rd., Pingzhen City, Taoyuan County 324, Taiwan</td>
</tr>
<tr>
<td>03-5325077</td>
<td>03-5320092</td>
<td>1F., No.9, Ln. 379, Sec. 1, Jingguo Rd., North Dist., Hsinchu City 300, Taiwan</td>
</tr>
<tr>
<td>04-23291388</td>
<td>04-23291338</td>
<td>3F., No.510, Yingcai Rd., West Dist., Taichung City 403, Taiwan</td>
</tr>
<tr>
<td>04-23805000</td>
<td>04-23806000</td>
<td>No.530, Sec. 4, Henan Rd., Nantun Dist., Taichung City 408, Taiwan</td>
</tr>
<tr>
<td>05-2784222</td>
<td>05-2784555</td>
<td>No.463, Zhongxiao Rd., East Dist., Chiayi City 600, Taiwan</td>
</tr>
<tr>
<td>06-2221666</td>
<td>06-2112555</td>
<td>No.141, Gongyuan N. Rd., North Dist., Tainan City 704, Taiwan</td>
</tr>
</tbody>
</table>
### Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product documentation, we provide the following sources for obtaining information:

**Your Dealer**

Don’t forget that your dealer can often help identify and resolve problems. The dealer should always be the first call for advise on problems; they can often solve problems quickly and easily as well as give advise on the next step to take.


Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The site provides a download area for drivers, Epson contact points, new product information and technical support (e-mail).

**Epson Helpdesk**

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the Helpdesk can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff can provide literature on new Epson products and advise where the nearest dealer or service agent is located. Many types of queries are answered here.

The Helpdesk numbers are:

- **Phone:** 1300 361 054
- **Fax:** (02) 8899 3789

We encourage you to have all the relevant information on hand when you ring. The more information you prepare, the faster we can help solve the problem. This information includes your Epson product documentation, type of computer, operating system, application programs, and any information you feel is required.

### Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:


Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries, and Technical Support via e-mail are available.
Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the phone:

- Sales enquiries and product information
- Product usage questions or problems
- Enquiries on repair service and warranty

Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and e-mail are available.

Epson Hotline (Phone: (66)2685-9899)

Our Hotline team can help you with the following over the phone:

- Sales enquiries and product information
- Product usage questions or problems
- Enquiries on repair service and warranty

Help for Users in Vietnam

Contacts for information, support, and services are:

Epson Hotline (Phone): 84-8-823-9239

Service Center: 80 Truong Dinh Street, District 1, Hochiminh City

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.id)

- Information on product specifications, drivers for download
- Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail
Epson Hotline

- Sales enquiries and product information
- Technical support

Phone (62) 21-572 4350
Fax (62) 21-572 4357

Epson Service Center

Jal. Arteri Mangga Dua, Jakarta
Phone/Fax: (62) 21-62301104

Bandung
Lippo Center 8th floor
Jl. Gatot Subroto No.2
Bandung
Phone/Fax: (62) 22-7303766

Surabaya
Hitech Mall lt IIB No. 12
Jl. Kusuma Bangsa 116 – 118
Surabaya
Phone: (62) 31-5355035
Fax: (62)31-5477837

Yogyakarta
Hotel Natour Garuda
Jl. Malioboro No. 60
Yogyakarta
Phone: (62) 274-565478

Medan
Wisma HSBC 4th floor
Jl. Diponegoro No. 11
Medan
Phone/Fax: (62) 61-4516173

Makassar
MTC Karebosi Lt. III Kav. P7-8
Jl. Ahmad Yani No.49
Makassar
Phone: (62)411-350147/411-350148
Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong Limited.

Internet Home Page

Epson Hong Kong has established a local home page in both Chinese and English on the Internet to provide users with the following information:

- Product information
- Answers to Frequently Asked Questions (FAQs)
- Latest versions of Epson product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:

Phone: (852) 2827-8911
Fax: (852) 2827-4383

Help for Users in Malaysia

Contacts for information, support, and services are:


- Information on product specifications, drivers for download
- Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Trading (M) Sdn. Bhd.

Head Office.

Phone: 603-56288288
Fax: 603-56288388/399
Where To Get Help

Epson Helpdesk

- Sales enquiries and product information (Infoline)
  
  Phone: 603-56288222

- Enquiries on repair services & warranty, product usage and technical support (Techline)
  
  Phone: 603-56288333

Help for Users in India

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers for download, and products enquiry are available.
Epson India Head Office - Bangalore

Phone: 080-30515000
Fax: 30515005

Epson India Regional Offices:

<table>
<thead>
<tr>
<th>Location</th>
<th>Telephone number</th>
<th>Fax number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mumbai</td>
<td>022-28261515 /16/17</td>
<td>022-28257287</td>
</tr>
<tr>
<td>Delhi</td>
<td>011-30615000</td>
<td>011-30615005</td>
</tr>
<tr>
<td>Chennai</td>
<td>044-30277500</td>
<td>044-30277575</td>
</tr>
<tr>
<td>Kolkata</td>
<td>033-22831589 / 90</td>
<td>033-22831591</td>
</tr>
<tr>
<td>Hyderabad</td>
<td>040-66331738/ 39</td>
<td>040-66328633</td>
</tr>
<tr>
<td>Cochin</td>
<td>0484-2357950</td>
<td>0484-2357950</td>
</tr>
<tr>
<td>Coimbatore</td>
<td>0422-2380002</td>
<td>NA</td>
</tr>
<tr>
<td>Pune</td>
<td>020-30286000 /30286001/30286002</td>
<td>020-30286000</td>
</tr>
<tr>
<td>Ahmedabad</td>
<td>079-26407176 / 77</td>
<td>079-26407347</td>
</tr>
</tbody>
</table>

Helpline

For Service, Product info or to order a cartridge - 18004250011 (9AM - 9PM) - This is a Toll-free number.

For Service (CDMA & Mobile Users) - 3900 1600 (9AM - 6PM) Prefix local STD code

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the Epson Philippines Corporation at the telephone and fax numbers and e-mail address below:

- Trunk Line: (63-2) 706 2609
- Fax: (63-2) 706 2665
- Helpdesk Direct Line: (63-2) 706 2625
- E-mail: epchelpdesk@epc.epson.com.ph


Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and E-mail Enquiries are available.

Toll-Free No. 1800-1069-EPSON(37766)
Our Hotline team can help you with the following over the phone:

- Sales enquiries and product information
- Product usage questions or problems
- Enquiries on repair service and warranty
# Index

## 2
- 2-Sided........................................................................................................ 57
- 2-sided printing.......................................................................................... 36

## A
- Aligning print head.................................................................................. 106
- Auto Answer............................................................................................ 65, 75
- Automatic Document Feeder (ADF)......................................................... 24
  - paper jams in....................................................................................... 125, 140
  - problems............................................................................................ 140

## B
- Banding.................................................................................................... 129
- Blank pages............................................................................................ 132
- Blurry prints........................................................................................... 130
- Broadcast Fax........................................................................................ 72

## C
- Canceling printing.................................................................................. 34
  - Mac OS X.......................................................................................... 35
  - Windows............................................................................................ 34
- Cleaning
  - print head......................................................................................... 105
  - product.............................................................................................. 110
- Clock...................................................................................................... 108
- Color problems..................................................................................... 129
- Contacting Epson................................................................................. 157
- Copying
  - basic.................................................................................................. 28
- Copyright............................................................................................... 2

## D
- Date/Time............................................................................................... 108
- Daylight Saving Time............................................................................ 108
- Documents
  - printing............................................................................................. 31
  - Driver.................................................................................................. 61
  - accessing for Mac OS X................................................................. 30
  - accessing for Windows.................................................................... 29
  - uninstalling........................................................................................ 114
- DSL......................................................................................................... 66

## E
- Easy Photo Print..................................................................................... 35
- Enlarging pages...................................................................................... 38
- Envelopes
  - loading.............................................................................................. 22
  - printable area.................................................................................... 149

## F
- Fax from a connected phone.................................................................. 74
- Fax header.............................................................................................. 70
- Fax information service......................................................................... 76
- Fax Report............................................................................................... 77
- Fax scheduled transmission................................................................... 73
- Faxing
  - receiving............................................................................................ 75
- Faxing to multiple recipients............................................................... 72
- Fit to page printing................................................................................ 38

## G
- Group Dial Setup................................................................................... 69

## H
- Head cleaning
  - control panel.................................................................................... 106
  - Mac OS X.......................................................................................... 105
  - Windows............................................................................................ 105
- Header.................................................................................................... 70
- Help
  - Epson............................................................................................... 157
  - Epson Event Manager...................................................................... 62
  - Epson Scan......................................................................................... 61
  - Home Mode........................................................................................ 48
  - Horizontal banding............................................................................ 129

## I
- Image Adjustment................................................................................... 45
- Incorrect characters............................................................................... 131
- Initialize............................................................................................... 143
- Ink
  - BK printing........................................................................................ 94
  - BK printing in Mac........................................................................... 96
  - BK printing in Windows.................................................................... 94
  - checking ink cartridge status in Mac OS X........................................ 92
  - checking ink cartridge status in Windows........................................ 91
  - checking ink cartridge status using the control panel...................... 93
  - precaution........................................................................................ 89
  - saving black ink in Windows............................................................. 97

Epson
- Easy Photo Print.................................................................................... 35
- paper..................................................................................................... 19
- Epson Connect.................................................................................... 9, 87
- Epson Event Manager......................................................................... 62
- Error messages.................................................................................. 118
- Errors
  - copy................................................................................................. 131
  - fax..................................................................................................... 144
  - print................................................................................................. 120
  - scan................................................................................................. 138

Epson
- Easy Photo Print.................................................................................... 35
- paper..................................................................................................... 19
- Epson Connect.................................................................................... 9, 87
- Epson Event Manager......................................................................... 62
- Error messages.................................................................................. 118
- Errors
  - copy................................................................................................. 131
  - fax..................................................................................................... 144
  - print................................................................................................. 120
  - scan................................................................................................. 138
Index

Scanner glass.................................................................26
Scanning software......................................................62
Send Fax Later.............................................................73
Service........................................................................157
Sharing printer
  Mac OS X.................................................................42
  Windows.....................................................................40
Smeared prints.........................................................130, 132
Software
  uninstalling..............................................................114
Specifications
  automatic document feeder.................................150
  fax...........................................................................150
  ink cartridges..........................................................146
  mechanical.............................................................151
  paper.......................................................................147
  printer......................................................................147
  scanner....................................................................149
  standards and approvals......................................154
Speed
  increasing.............................................................132, 136
Speed Dial Setup.........................................................68
Status lights.............................................................138
Status Monitor
  Mac OS X.................................................................122
System requirements.................................................146

T
Technical support.....................................................157
Text
  printing documents.................................................31
Trademarks....................................................................2
Transporting product.................................................111

U
USB
  connector................................................................155

W
Web service.............................................................9, 87
Windows
  accessing printer settings.................................29
  checking product status...................................121
  managing print jobs..........................................121